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The	  transition	  from	  an	  academic	  atmosphere	  to	  the	  professional	  world	  is	  an	  

important	  step	  in	  a	  college	  student’s	  life.	  	  The	  use	  of	  traditional	  teaching	  methods	  

has	  been	  the	  subject	  of	  ongoing	  research	  into	  how	  well	  they	  prepare	  students	  for	  

this	  transition.	  	  	  

The	  evolution	  of	  technology	  and	  the	  state	  of	  the	  nation’s	  economy	  continually	  

require	  entry-‐level	  employees	  to	  display	  broader	  skillsets.	  	  Competencies	  such	  as	  

critical	  thinking,	  creativity,	  and	  technical	  accuracy	  are	  three	  off	  the	  primary	  

attributes	  of	  a	  well-‐prepared	  college	  student	  transitioning	  into	  a	  creative	  or	  design	  

industry.	  	  Within	  traditional	  teaching	  methodologies,	  technical	  accuracy	  has	  been	  

the	  primary	  outcome	  of	  the	  learning	  environment.	  	  These	  traditional	  methods	  often	  

fall	  short	  in	  preparing	  students	  for	  other	  the	  necessary	  competencies.	  

This	  study	  explores	  the	  application	  of	  two	  teaching	  methodologies	  –	  

behaviorist	  and	  constructivist	  –	  and	  their	  effects	  on	  accuracy,	  retention,	  and	  

behavior	  among	  college	  students	  in	  an	  interior	  design	  studio	  classroom	  setting.	  	  

Two	  separate	  groups	  of	  participants	  engaged	  in	  a	  learning	  experience	  that	  followed	  

either	  a	  behaviorist	  methodology	  or	  a	  constructivist	  methodology.	  	  Participants	  

learned	  software	  and	  completed	  an	  electronic	  drawing	  that	  was	  assessed	  for	  
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accuracy	  and	  creative	  embellishment	  by	  the	  researcher.	  	  Additionally,	  participants	  

submitted	  surveys	  after	  each	  learning	  session	  that	  described	  their	  experience	  from	  

the	  perspectives	  of	  learner	  confidence,	  value	  of	  learned	  skills,	  and	  difficulty	  of	  the	  

learning	  session.	  	  Finally,	  learner	  behavior	  was	  analyzed	  through	  visual	  

observations	  made	  by	  trained	  individuals	  during	  the	  learning	  sessions.	  

Data	  showed	  a	  clear	  difference	  in	  many	  of	  the	  assessed	  categories	  between	  

the	  methodologies	  applied.	  	  While	  accuracy	  levels	  were	  high	  in	  both	  approaches,	  in	  

most	  other	  categories,	  students	  participating	  in	  the	  constructivist-‐based	  groups	  

exhibited	  higher	  scores.	  	  It	  is	  recommended	  that	  creative	  studio	  classes	  implement	  a	  

hybrid	  approach	  that	  utilizes	  facets	  of	  both	  behaviorist	  and	  constructivist	  

methodologies,	  and	  also	  that	  further	  research	  be	  conducted	  with	  larger	  groups	  of	  

learners	  with	  a	  wider	  array	  of	  prior	  academic	  performance	  levels.	  	  Findings	  were	  

encouraging	  in	  support	  of	  an	  academic	  goal	  to	  better	  preparing	  students	  for	  a	  

professional	  transition.	  
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CHAPTER I 

INTRODUCTION 

Overview 

Teaching at the college level grows more challenging as technology advances and 

expectations for transitioning entry-level employees rise.  Students find that simply 

learning technology from a technical perspective does not properly prepare them for the 

workforce, and many teachers are challenged to add additional levels of instructional 

content into curriculums.  Creativity, critical thinking, and interpersonal teamwork skills 

are all value-added characteristics of a marketable individual, and teaching these concepts 

is becoming more important to prepare students for post-graduation.   

Instruction is typically applied in either a behaviorist or constructivist manner, 

sometimes as a combination of the two.  The behaviorist approach can be simply 

described as rote learning.  A teacher provides content in the form of lecture or written 

material, and it becomes the individual’s responsibility to memorize or process the 

information.  Assessment of this method usually takes the form of a written or oral 

examination where the student restates the information learned.  In a constructivist-

structured classroom, teachers are more likely to use methods beyond lecture and written 

text, and place greater emphasis on project-based learning, teamwork, and individualized 

goal-setting.  Students have greater control over the process by which content is learned, 

since this approach values a more self-directed style of learning that is largely facilitated 

rather than directed.  The participation within the learning environment puts more 

responsibility onto students for the outcomes of instruction. 
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Teaching in a studio setting brings about a unique challenge for instructors, 

especially where software is involved in the curriculum.  A teacher must provide a 

learning environment that supports technology instruction as well as application of the 

technology to a greater purpose.  An additional level of need arises in instances where 

creativity is an expected output of learning.  Not only is creativity subjective in nature, 

but also is strongly tied to both the individual and the learning environment.   

 The Interior Design (INDS) curriculum at Indiana University of Pennsylvania 

(IUP) has traditionally implemented a behaviorist approach to learning, both in lecture-

based classrooms as well as studio-based.  The ever-changing requirements of potential 

employers on graduating students are challenging those teaching the curriculum in a way 

that requires alternate teaching methods.  It is no longer sufficient for students to learn the 

standard processes of a computer-based design program and be competitive in today’s 

professional society.  Further, the ability to demonstrate critical thinking and creativity 

are paramount to a student’s transition into the workforce.  These skills are not easily 

taught, monitored, or evaluated using a behaviorist approach.  This study will 

demonstrate the application of software instruction in a behaviorist method and a 

constructivist method, and explore the differences in student achievement, retention, and 

creativity that each presents. 

Behaviorist Approach 

Lecture-based delivery and demonstration is often utilized as a standard 

behaviorist approach to learning, where the student is seen as an unreflective responder 

(Boghossian, 2006).  For lower-level foundation classes that have learning goals limited 
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to simple knowledge transfer, this is accepted as an effective approach.  This can also be 

the case with technology curriculum that intends to teach the mechanical processes of 

software or process.  

Rajendran & Clarke (2011) describe Building Information Modeling (BIM) 

software as a digital way to “walk into a building, walk through the lobby, remove the 

ceiling tiles and look at the utilities in the ceiling space - before the building is even built 

(p.45).”  For a studio-based class, learning goals often reach beyond process and software 

into creativity and self-expression without the instructional system to support it.  INDS 

students who are learning BIM at IUP are subject to this approach - the assessment phase 

of the course is based upon accurate representations of preconceived space drawings 

pulled directly from a textbook.  Ediger (2012) discusses the process in which material is 

learned under a strictly behaviorist approach.  With assessments that are generalized, 

students have far less control over the learning process.  Differentiated instruction (a 

method of tailoring instruction to students with multiple levels of prior knowledge and 

learning abilities within a single classroom) is difficult to apply in a classroom in which 

behaviorist pedagogy is in place.  A specific amount of content has been determined 

necessary in preparation for assessment, leaving little room for individual monitoring and 

coaching within the constraints of classroom learning.  Pugsley (2011) asserts the 

controlling nature of this teaching methodology, that behaviorism has a more limited 

success in the attainment of learning goals in the 21st century classroom.  The behaviorist 

approach in the studio setting provides a setting where students follow step-by-step 

instructions to learn technical skills.  Textbooks are highly utilized in this regard, 

especially those that provide tutorials and detailed examples of technique.  In a typical 
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interior design studio that follows this methodology, students work to achieve the same 

result, such as creating an electronic drawing of an executive meeting room, a financial 

planning office, a hotel room, or even a residential home.  Key features of the program 

are introduced through lessons that may take an entire semester, depending on the course 

layout.  The final drawing is illustrated in the textbook, so students are able to compare 

their product to the original before submitting it to the instructor for evaluation. 

Constructivist Approach 

At the core of the constructivist approach, the individual is supported in his or her 

journey of constructing knowledge (Kalina & Powell, 2010).  The constructivist approach 

allows for human emotion, social interaction, and a more empowered sense of learning to 

bring about greater gains to the learner.  This is especially important in a learning 

environment that teaches software, particularly because, while technology has allowed 

user interfaces to become easier to learn, the complexity and depth of many design 

programs has greatly increased.  Vygotsky’s (1978, 1986) social constructivist theory 

supports the implementation of project-based learning and peer-based teaming and 

assessment.   Given the requirement for more effective teaching methods and better 

results, the researcher wishes to assess if this approach will allow for a more accurate and 

creative learning process.  The constructivist approach serves as the polar opposite of the 

behaviorist theory.  Where the behaviorist method bases achievement on the ability for a 

student to reiterate lectured content or written text accurately, the constructivist method 

digs deeper into the construct of the learning environment and gives students the 

opportunity to participate in a learning experience with goals that he or she shares more 

responsibility for setting and achieving.  Palincsar (1998) references a radical version of 
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constructivism in which the idea of objective knowledge is completely discarded and 

knowledge is purest when it comes as a result of peer engagement.  While the application 

of this progressive version of constructivism would be risky, an interpretation of the core 

value can be utilized to bring about a richer learning experience.  Green & Gredler (2002) 

suggest that the wide array of constructivist beliefs can be condensed into two 

foundational theories as applied to curriculum development: 1) Learners gain more 

valuable knowledge through peer engagement, and 2) the implementation of 

constructivist methods will require a great modification to classroom dynamics.  In this 

approach, as it pertains to interior design, students are introduced to computer software 

by short lessons during the first week or two of the semester, where the instructor 

highlights key components or functions within the program (e.g. drawing an interior wall, 

providing seating, or determining that a space meets federal requirements for universal 

design).  Students are then assigned a project with basic requirements, such as the setting, 

where they can apply evidence-based design research to generate space, scale, and 

interior elements.  While constructing the space electronically, students are 

simultaneously learning the software skills and applying creative licensing to their 

product.  Each student’s project will be slightly to moderately different from his or her 

peers’, and no final example is available for them to see ahead of time prior to submitting 

to their instructor. 

Rationale for the Study 

Meneely & Danko (2007) acknowledge a relationship between design students 

and technology wherein the technical factors meld with cultural and personal dynamics to 

influence creativity.  At the post-secondary level, creative and technical studio courses 
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cross many disciplines within the arts accept students from different backgrounds and 

learning styles.  For this reason, a challenge teachers are facing in post-secondary 

education is a continuing demand for differentiated instruction within classrooms.  Not 

all students will have the same background in the content being taught, and this is 

especially true within classes teaching technology.  As a trend, students continue to be 

more technology-savvy as society grows in digital capability, however the levels of 

knowledge in regards to software are still widely varied from student to student.  Those 

enrolled in software-based studio courses are typically asked to provide evidence of 

learning through the application of technical skill, critical thinking, and creativity.  With 

the traditional behaviorist model, technical skill is easily assessed.  Creativity and critical 

thinking are more difficult to assess, due to their inherent subjectivity.  The constructivist 

model, in theory, builds in aspects of learning and interaction that could make these 

subjective elements more achievable by students.  

Rationale for the Sample and Focus 

Faculty of design courses in higher education must be equally creative in 

balancing hand drafting and Computer-Aided Drafting and Design (CADD) skills while 

promoting levels of retention.  Students preparing for entry into the interior design field 

have been required to increase the level of digital competency throughout their post-

secondary education.  While skills such as hand-drafting and hand-rendering were 

sufficient for students to master decades ago, students must now add enhanced electronic 

skills and software to their portfolios (Pektas & Erkip, 2006).  To align itself with 

national patterns that have reduced face-to-face time between students and faculty, IUP 

has adapted a university-wide deduction of ten minutes from every lecture hour.  Coupled 
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with the need to teach various software platforms beyond the standard methods of hand-

drafting and rendering, it challenges students enrolled in Interior Design studio courses in 

the successful retention of a growing amount of material.  The goals of the Interior 

Design program at IUP as related to digital software education are twofold: 1) Teach the 

student how to use the software, and 2) teach the student how to use the software in the 

context of higher-order thinking with an emphasis on creativity.  The first concept 

involving teaching the software has become part of the standard curriculum, and is easily 

taught and assessed using the current behaviorist teaching approach.  The second moves 

deeper into the need for students to learn technical skills as a basis for learning to 

communicate creatively and efficiently – skills that employers in the design field expect 

as core competencies.   

The Council for Interior Design Accreditation (CIDA) 2011 Professional 

Standards document lists the following competencies for students.  Requiring that they 

demonstrate the ability to: 

1. identify and define relevant aspects of a design problem (goals, objectives, 

performance criteria). 

2. gather, evaluate, and apply appropriate and necessary information and 

research findings to solve the problem (pre‐design investigation). 

3. synthesize information and generate multiple concepts and/or multiple design 

responses to programmatic requirements. 

4. demonstrate creative thinking and originality through presentation of a 

variety of ideas, approaches, and concepts. 
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This study aims to explore the possibility that through the application of a 

constructivist teaching method, software can be taught in a way that better supports 

accuracy and retention, and creativity output can be measurably increased. 

Background 

Students majoring in Interior Design at the higher education level are faced with a 

growing need to infuse creativity with technology.  Building Information Modeling and 

Computer Aided Drafting programs such as AutoCAD, Revit, SketchUp, and 20/20 

enable the student to express their visual designs on the screen and further by print.  

These four programs are widely recognized throughout the interior design and 

architecture industries as paramount to conducting business in various sections.  This 

shift in dependence on technology places a heavy burden on the student and the 

instructor.  Like most studio-based art and media courses, theory development and the 

fine art aspects of interior design remain historically vital to developing one’s craft; 

however, this shift adds another layer of digital communication interwoven into 

curriculum without a corresponding expansion in delivery time.  As a result, either 

curriculum should be modified, or more likely, delivery methods need to be modified to 

better support conceptual learning. 

Disciplines that are based in the design and creation of built environments require 

increasingly agile development teams.  Construction of new living and commercial 

spaces (as well as the redesign and retrofitting of old spaces) has been elevated to a 

higher level of complexity with new layers of needs such as environmental influences 
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that have blazed the trail for green design and a strong push toward understanding and 

implementing efficiency.   

Students of the built environment are placed in a position of learning a typically 

rigid curriculum and producing even more typically rigid results.  The concept of a 

standard curriculum is constantly at war with the unpredictability of a student’s creative 

potential.  Given the unpredictable pathways that students in a studio setting are apt to 

follow, it is not surprising to find that these students require a learning method that is 

both rigid and flexible (Tucker & Morris, 2012).  

As the goal of any educational institution is to prepare a student for transition to 

the professional world, instructors and teachers bear the responsibility of ensuring that 

curriculum application is both accurate and beneficial to the current state of the particular 

academic program and its student base.  Accrediting bodies, such as CIDA, provide 

valuable guidance in preparing students for a successful transition to the professional 

world.  CIDA (2011) requires all accredited Interior Design Programs to include (for its 

enrolled students): 

1. opportunities to solve simple to complex design problems. 

2. exposure to a range of design research and problem solving methods. 

3. opportunities for innovation and creative thinking. 

4. opportunities to develop critical listening skills. 

 

Rigor and determination in these five areas are vital to the progression of a degree 

program so that prepared students are prepared to thrive in a professional atmosphere.   
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The Interior Design Program at IUP faces this same concern within the 

development and revision of its curriculum.  The researcher wishes to compare two 

methods of teaching studio courses to determine whether either or both have the potential 

to produce the amount of creativity and accuracy necessary for a student to transition into 

a profession in which built environments are of primary concern.  Students enrolled in a 

studio course experience only three hours and twenty minutes of instruction per week.  It 

is hypothesized that the application of a modified teaching method that encourages 

attributes of a social constructivist approach will allow students to better retain technical 

skill, allowing for further critical thinking development and creativity.   

Purpose of the Study 

The intent of this study is to explore how behaviorist and constructivist 

approaches to learning impact the student’s level of retention in software-based studio 

classes.  Support for both methods will be derived from data showing an undergraduate 

student’s ability to retain and accurately utilize BIM software; which has an increasing 

presence in contemporary studios.  Additionally, this study will assist in providing a 

better comprehension of alternative methods of teaching technology to Interior Design 

students.  Currently, all Interior Design courses at Indiana University of Pennsylvania 

(IUP) are being taught in the classroom, however, a future demand will most likely arise 

for faculty to offer online instruction of select courses.  Results from this study will be 

beneficial to gain insight in the student’s retention level of a specific technology when 

this need arises. 
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IUP’s Bachelor of Science degree in Interior Design contains a mixture of studio 

and lecture courses in the major, along with Liberal Studies and other electives.  Interior 

Design educators must recognize the most efficient way of introducing a new technology 

into the curriculum, since new content must be incorporated into a current Interior Design 

course at this time, as there is no room to rearrange the curriculum. 

Research Questions 

This study aims to determine the level of impact of Learning Theory Methods on 

an undergraduate’s retention and application of software in a studio setting.  The 

researcher plans to relate the infusion of project-based learning in a constructivist 

approach with an increase in student retention of software knowledge.  This is a means to 

an end, one that might allow software to become more of a support to higher-level 

learning than it currently is within the construct of interior design instruction at IUP.  

With this intent, the following research questions are proposed: 

 

RQ1: What is the effect of instructor interaction on a student’s ability to apply 

and retain knowledge in a studio setting, as measured by rubrics that assess 

accuracy?   

 

RQ2: Does the instructor’s choice of a constructivist approach versus behaviorist 

impact students’ behavior during and attitude towards studio-based learning, as 

measured by student surveys, observed learning indicators, and creative output? 
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These questions will be explored through four experimental learning sessions 

between two similar learning groups (see Figure 2).  The researcher plans to use 

observation and survey data to discover the impact of teaching methodologies and 

learning environments on student achievement, retention, creativity, and behavior. 

Introduction to the Methodology 

To present plausible and value-added data, a comparison study will be performed 

consisting of two separate experiments; one in which an instructional model founded in 

behaviorist strategy is implemented, and another in which a constructivist strategy is 

utilized.  The two groups will be determined using matched pairing from demographic 

surveys, ensuring a balanced sampling for each group. 

The foundation for this experiment lies within the context of teaching 

methodologies implemented in studio-based post-secondary courses.  While the results of 

the experiment could theoretically be applied to multiple disciplines that teach creative 

studio-based courses, the Interior Design curriculum is targeted in this study.  The goals 

of the experiment are to provide evidence surrounding both a behaviorist and 

constructivist method of teaching and to determine which of the two methods are better 

suited for promoting retention and higher-order thinking among students in a studio 

setting through assessments of accuracy, creativity, and observations of learning 

behaviors exhibited.  Further, this study will utilize a quantitative-based approach to 

explore the effects on retention skills of undergraduates using BIM.   

Human retention of information will be identified via Lang’s (2006) limited 

processing model.  Technical evaluation of the project will be performed using the 
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Evaluation Protocol found in Appendix J of this document.  Self-efficacy will be 

determined through observations as well as data extracted from the post-test surveys 

administered at the conclusion of each session.  Nielsen et al. (2010), tie Bandura’s 

(1977) concept of self-efficacy to students who need to use technology and develop self-

confidence to express and communicate intended designs.  While transferring hand-

sketched ideas to the electronic platform on a PC, students are essentially learning 

another language to communicate and conceptualize ideas.  As this study examines two 

different teaching methods, data showing self-efficacy for future retention, both 

perceived and actual, are essential to determine the success of each method.  Assessment 

of the completed projects will translate as evidence for retention, and perceived self-

efficacy will translate as evidence for confidence in the creative application of learned 

concepts. 

Conclusion 

This study aims to deepen understanding surrounding the current and future needs 

of studio-based creative studio classrooms as technology evolves and requirements of 

student retention grow more complex.  Chapter two will offer context for the experiment, 

providing a knowledge base and literature review around core development ideas 

including teaching methodologies, application of instruction in a creative atmosphere, 

and learning theory.  Chapter three will discuss methods for conducting this study.  

Chapter four will provide evidence using data from a two-part experiment involving the 

teaching of a studio lesson utilizing two different methods.  Chapter five will offer 

conclusions and recommendations based upon findings. 
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CHAPTER II 

REVIEW OF LITERATURE 

Overview 

Creativity, critical thinking, and interpersonal teamwork skills are essential to 

those entering modern-day professional society.  The economy constantly dictates and 

shapes the ideal makeup of the efficient and valuable employee.  Those seeking longevity 

in the creative atmosphere must be able to effectively utilize software to support an 

overarching application of intangible skills.  Critical thinking has become an important 

competency that employers seek.  Self-direction, motivation, and other interpersonal 

skills are further at the forefront of hiring requirements.  For a technology-centered 

career, technical ability holds merit.  For a creative technology career such as Interior 

Design, technical ability must be inherent and act as a supporting rung for these 

intangible factors.   

Learning digital skill as it relates to the Interior Design field is not only 

imperative from a visual drawing and rendering standpoint, but more appropriately as for 

the whole of visual communication.  Students venturing into this career path must grasp 

technology from a multi-level approach; technical ability of software, media design for 

presentation, and a combination of the two for portfolio development and maintenance.  

For a young adult with little to no software experience, it can be a daunting task simply to 

acclimate themselves with required software, let alone develop his or her visual palette.   

Over the past decade, class times have decreased while class sizes increased, a 

commonality to many post-secondary institutions.  Efficiency of teaching is becoming 
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more pertinent to the success of the curriculum, but this does not address the need to 

further engage students and place more of the responsibility for academic achievement on 

an intrinsic motivational platform.     

Behaviorist Learning Environment 

Boghossian (2006) notes that the behaviorist model focuses primarily on external, 

observable motivations and assesses achievement by analyzing response data, both 

written and oral, of the student.  He further explains that the behaviorist model openly 

rejects the interpersonal components of classroom learning.  Fischer (2001) lists four 

global issues within the field of education in response to entry into the information age: 

1. Lack of creativity and innovation 

2. Inability to cope with change 

3. Insufficient support for school-to-work transition 

4. Domination of the “gift wrapping” approach to educational reform 

 

These elements are direct legacies from a purely behaviorist model of instruction.  

Fischer talks about the nature of these four elements as they pertain to the progression of 

educational curriculum and the issues that they bring to the modern student.  The lack of 

creativity and innovation is a concept that Fischer describes as something that inhibits 

students from being taught how to “work smarter, not harder.”  In today’s society, an 

employer is typically not looking just for an employee that knows the most about a 

particular subject, especially if that knowledge comes with a lack in other areas such as 

creativity and critical thinking.  Fischer refers to coping with change to describe the 
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historical value of the behaviorist model in preparing the student for what was typically a 

lifelong career.  Today, career changes are frequent, job changes much more so, and 

students need to be prepared to be nimble and tenacious in their learning.  He goes on to 

talk about the lack of preparation for the level of collaboration and teamwork necessary 

for a professional transition.  This concept is paramount in reviewing if a behaviorist-

grounded teaching method is appropriate for a particular subject or content area.   

Below is a visual representation of the behaviorist approach to curriculum 

development, created by Shepard (2000).   

 

Figure 1. Venn Diagram Illustrating the Behaviorist Approach (Shepard, 2000) 

 

The Curriculum of Social Efficiency 

"? Scientific management of schools like factories 
"* Carefully specified educational objectives 
based on job analysis 

"* Utilitarian content, antagonism toward 
academic content except for elite few 

"* Science of exact measurement, precise 
standards 

"* Differentiated curriculum based on predicted 
social roles 

Hereditarian Theory of Intelli ce 

"* IQ as innate, unitary, and fixed 

Associationist & Behaviorist Learning Theor es Scientific Measurement 
"* Concept of mind replaced by stimulus-respons 
associations * IQ tests to sort pupils by ability 

"* Accumulation of atomistic bits of knowledge 
"* Learning tightly sequenced & hierarchical * Objective tests to measure 
"* Limited transfer, each objective taught explicitly achievement 
"* Test-teach-test to ensure learning 
"* Tests isomorphic with learning 
"* Motivation based on positive reinforcement of 
many small steps 

FIGURE 2. Interlocking tenets of curriculum theory, psychological theories, and measurement theory characterizing the 
dominant 20th-century paradigm. 

cantly, teachers wanted their assessments to be "objective," 
and this was the word they used. They worried often about 
the subjectivity involved in making more holistic evalua- 
tions of student work and preferred formula-based meth- 
ods, such as counting miscues, because these techniques 
were more "impartial." 

Any attempt to change the form and purpose of class- 
room assessment to make it more fundamentally a part of 
the learning process must acknowledge the power of these 
enduring and hidden beliefs. 

Conceptual Framework: New Theories of Curriculum, 
Learning, and Assessment 
To consider how classroom assessment practices might be 
reconceptualized to be more effective in moving forward the 
teaching and learning process, I elaborated the principles of 
a "social-constructivist" conceptual framework, borrowing 
from cognitive, constructivist, and sociocultural theories.1 
(Though these camps are sometimes warring with each 

other, I predict that it will be something like this merged, 
middle-ground theory that will eventually be accepted as 
common wisdom and carried into practice.) The three-part 
figure (Figure 4) was developed in parallel to the three-part 
historical paradigm to highlight, respectively, changes in 
curriculum, learning theory, and assessment. In some cases, 
principles in the new paradigm are the direct antitheses of 
principles in the old. The interlocking circles again are in- 
tended to show the coherence and inter-relatedness of these 
ideas taken together. 

The cognitive revolution reintroduced the concept of 
mind. In contrast to past, mechanistic theories of knowl- 
edge acquisition, we now understand that learning is an ac- 
tive process of mental construction and sense making. From 
cognitive theory we have also learned that existing knowl- 
edge structures and beliefs work to enable or impede new 
learning, that intelligent thought involves self-monitoring 
and awareness about when and how to use skills, and that 
"expertise" develops in a field of study as a principled and 

6 EDUCATIONAL RESEARCHER 
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Shepard (Ibid.) listed key components of a behaviorist teaching method that 

described both content and assessment: 

1. Learning occurs by accumulating atomized bits of knowledge. 

2. Learning is tightly sequenced and hierarchical. 

3. Transfer is limited, so each objective must be explicitly taught. 

4. Tests should be used frequently to ensure mastery before proceeding to 

the next objective. 

5. Tests are isomorphic with learning (tests=learning). 

6. Motivation is external and based on positive reinforcement of many 

small steps. 

As Shepard describes, this methodology is limited in its capability for teaching 

critical thinking.  To teach critical thinking, students must be given multiple avenues 

and/or levels of success that he or she must be allowed to follow based on self-discovery.  

Ediger (2012) describes the behaviorist learning environment as a highly sequential 

methodology that relies solely on the prescribed learning activities of the instructor, 

which allows little to no participation of the learners in the process by which content id 

delivered.  No subjective elements are involved in delivery or assessment during the 

learning process, which intentionally leaves little room for interpretation by the student 

(Boghossian, 2006).  This approach can be quite limiting in classrooms that intend to 

deliver content that would benefit from student input or subjective assessment such as 

design elements or creativity (Pugsley, 2011) 
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It is easy to see how instruction under the behaviorist model depends greatly on 

data and standardized testing.  This standard process of teaching small parts of content in 

a repeating fashion has merit in a certain level of implementation.  Many concepts within 

science and mathematical curriculum are not debatable, and teaching with this approach 

is necessary and valid.  Classrooms grounded in behaviorism place the student in the role 

of a consumer – information is presented and either learned or reiterated and practiced 

until learned.  Active participation of the student is limited for the most part to the 

assessment phase, where he or she demonstrates the learned content to the teacher.  In 

order to be “fair,” testing of content must be identical so that no student has a perceived 

advantage over another by way of an alternate assessment element.   

Constructivist Learning Environment 

The Constructivist Learning Environment (CLE) is a learning environment where 

social interaction, dynamic inquiry, and metacognitive reflection are paramount to the 

student’s success (Sultan et al., 2011).  They cite scholars (Taylor & Fraser, 1991; 

Johnson & McClure, 2000; McClure & Gatlin, 2007) in discussing the following five 

elements that support the implementation of a CLE.  First, drawing on students’ personal 

lives and out-of-school experiences sets the basis for connecting learning to the outside 

world, promoting relevancy.  Second, students must realize that scientific knowledge is 

theory-based and that human experience allows this theory to socially and culturally 

evolve.  Third, students must be given a “voice.”  This is not to say that disruption is 

allowed within the learning environment to a detrimental level.  It simply means that 

students should be encouraged to participate in their learning experience and submit 

suggestions and inquiry when they feel unchallenged or confused.  Fourth, like the 
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previous element, students should not only be encouraged to support the learning 

environment, but also engage in discussion that surrounds the learning goals and 

assessment criteria.  Finally, the concept of bringing students into the discussion around 

the environment as a whole is the most influential foundation to a CLE, promoting the 

idea of negotiation and tying the student’s performance to not only theory, but also social 

and academic interaction between peers and the teacher.  Establishing a CLE in the 

classroom traditionally run as theory-based or lecture must begin with the application of 

new teaching methods that support this change.   

Honebein (1996) quotes Cunningham, Duffy, & Knuth (1993) and Knuth & 

Cunningham (1993) in listing the seven pedagogical goals that designers of constructivist 

learning environments aim to achieve: 

1. Provide experience with the knowledge construction process. 

2. Provide experience in and appreciation for multiple perspectives. 

3. Embed learning in realistic and relevant contexts. 

4. Encourage ownership and voice in the learning process. 

5. Embed learning in social experience. 

6. Encourage the use of multiple modes of representation. 

7. Encourage self-awareness of the knowledge construction process. 

 



	   20	  

 Utilization of these concepts can provide a successful learning environment where 

students not only learn the content presented, but also participate within the learning 

environment as more than just students.  Allowing students the opportunity to participate 

in the selection of content as well as the primary mode of learning, places a recognizable 

responsibility for the quality of learning to be achieved.  The CLE provides a way to 

explore different solutions to problems that students might face in real-world scenarios.  

A main foundation for these seven goals is to provide students with a sense of ownership 

over their collective and individual learning experiences, motivating students to breathe 

more life into the process and share the rewards.  

Jonassen and Rohrer-Murphy (1999) further support this concept by offering the 

interdependent components of a CLE – they label them as “problem-project spaces, 

related cases, information resources, cognitive tools, and conversation/collaboration 

tools.”  In essence, the foundation of a CLE is setting an environment where project-

based learning can thrive.  The learners must be provided a vehicle for research, and be 

exposed to real-world scenarios that relate directly to the content being delivered.  With 

the group-learning construct that facilitates and encourages peer feedback and discussion, 

learners can begin to feel responsible for their own learning experience.   

Implementing a CLE in a classroom where a traditionally behaviorist model has 

been used is not an overnight transition.  First, the perception of traditional learning must 

be challenged from the instructor’s standpoint.  Both the instructor and student must be 

harmonious in sharing a positive classroom climate, even while the basis for each is 

typically different; students rely on social approval and recognition, while instructors rely 

on management of student behaviors, information processing, and learning outcomes 
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(Myers & Rocca, 2001).  Largely, this shift in climate is brought about unawares to the 

learner, at least in the beginning stages.  A change in inquiry method, increase in 

cooperative learning activities, the addition of dedicated time that allows peer discussion 

and debate can quickly begin the transformation to a student-centered learning 

environment.    

CLE integration often falls short of the potential for impact (Shaw, 2011).  

Meneely & Danko (2007) discuss the tendency for curriculum to focus too much on 

learning how to use software alone, and not enough on the application of software in real-

world learning exercises.  This brings light to the inevitable need to modify the process of 

developing studio curriculum, and more importantly, the application of such curriculum.   

In the case where a CLE is implemented, technology is often used in research and 

exploration in conjunction with problem-solving techniques that aid individual learning 

(Hannafin et al., 1997).  The typical studio course in which software is taught utilizes a 

step-by-step learning process, focusing more on the application of technical concept over 

the application of that concept to a greater goal.  In many cases, so much emphasis is 

placed on regurgitation of learned technical skills that students have little or no applicable 

knowledge of how to utilize the new skill in his or her career path.     

Project-based learning brings the onus of learning to the student (Boondee et al., 

2011).  Students are required to interact with peers, form learning communities, and 

assume more of the responsibility for achieving learning goals than they might have in a 

traditional lecture format.  Students’ perception of achievement, understanding of 

learning, and the interaction with others within the academic environment are prime 
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factors that allow learning goals to be achieved (Panasan & Nuangchalerm, 2010).  This 

application of cooperative learning is a foundational practice that will begin to shift the 

traditional classroom to one of student-centered learning.   

Five elements combine to form the base for cooperative learning: positive 

interdependence, social skill, individual accountability, group processing, and face to face 

promotive interaction (Boondee et al., 2011; Trytten, 1999; Johnson & Johnson, 1994; 

Slavin, 1987; Sharan & Sharan, 1976, 1992; Kreijns et al., 2003).  These elements, if 

supported and encouraged, will allow students to begin exploring the dynamic of their 

group, examine their personal contribution to the overall goals of the group, and 

ultimately realize the importance of the group’s success as a learning objective.  The 

climate of cooperative learning techniques breeds student confidence if applied with care 

and precision.  Students that have confidence in their technology-based skillset are more 

likely to use these skills to achieve a more globalized goal around their individual and 

group design intentions (Neilsen et al., 2010).  A method to employ this confidence is 

evident in the application of group dynamics.  For example, a student required to design 

an entire space will gain a broad knowledge of many separate concepts.  Conversely, a 

group of students that each have a focus on small parts of a whole will allow for greater 

technical skill gains as well as conceptual design knowledge (Wallick & Zaretsky, 2010).   

Savery & Duffy (1995) assert that collaborative groups can test the understanding 

of students by providing a vehicle for “enriching, interweaving, and expanding” the 

learning goals of a group learning experience.  Group learning is a method that moves 

beyond individual understanding and adds a dynamic of social interaction.  In studio-

based classes, this can be valuable as a tool to bring about higher-level thinking.  
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Traditional classrooms have more opportunities to employ this concept, but as Hannifin 

et al. (1997) suggest, schools often provide context and intent to teach and nurture critical 

thinking and/or problem solving, but remain focused on a behaviorist model of 

instruction where declarative knowledge is the primary goal of learning.   

Learners are as likely to be influenced by their learning environment to grow 

human memory and intelligence as they are by the content being presented (Dede, 1996).  

The many perspectives and backgrounds displayed by other participants in the learning 

environment are invaluable to setting the foundation for a greater foundation of learning 

for the group as a whole.  An environment that promotes a collaborative academic 

relationship with peers has been shown to influence deeper learning, critical thinking, and 

a strong retention of content (Kreijns et al., 2003; Garrison et al., 2001; Johnson & 

Johnson, 1999).  Honebein (1996) discusses how learning in a social or collaborative 

environment forces this idea of multiple perspectives.  He further discusses how these 

collaborative learning experiences aid in seating learners into various roles of 

practitioners, including teamwork, leadership, negotiation, and cooperation.   

Cognitive Load Theory 

 Cognitive Load Theory (CLT) is used to predict learning capability and influence 

teaching methodologies.  Research on CLT can have a strong influence on the affects of 

certain instructional approaches to curriculum that teaches subjective content.  Cognition 

and learning are subjects that have been analyzed extensively to influence teaching 

methods and inform and advance understanding from a scientific perspective (Collins, 

Greeno, & Resnick, 1992).  CLT relies on the research of how delivered content affects 
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the mind and uses this research to influence modes of instruction (Van Merrienboer & 

Sweller, 2005). 

Cognitive load is critical to designing activities that do not overload a learner’s 

ability to comprehend or retain information.  CLT analyzes the amount of cognitive 

activity a learner experiences on a given instructional task (Paas & Van Merrienboer, 

1994).  Research on CLT influences non-technical competencies of a learner, including 

comprehension and problem solving (Collins et al., 1992). 

Cognitive load and the effect it has on a learner’s ability to comprehend 

information can have a great influence on his or her success in a classroom environment.  

The acknowledgment of the relationship between cognitive and the working mind can 

have a positive influence on a student’s ability to retain information.  Regardless of the 

type or amount of content being delivered, it is the interaction of the elements of learning 

that determines the amount of cognitive load experienced at any given time (Paas, Renkl, 

& Sweller, 2003).  The application of improper teaching strategies can unintentionally 

engage learners in multiple cognitive processes, which in turn increases short-term (or 

working) memory load (Mousavi, Low, & Sweller, 1995).  Further, Miller (1956) and 

Baddeley (1992) suggest that working memory loads peak at seven simultaneous items 

for the average learner, and Kirschner (2002) believes that a number of core processes 

that are already running reduce that number to three simultaneous items. 

BIM, CAD, and many design software packages today are exponentially more 

powerful and intricate than they were five years ago.  Awareness of cognitive load among 

learners when a foreign software is being taught is a concept that can drastically improve 
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retention levels among the average college student.  By ensuring students are focused on 

learning content in small pieces instead of multitasking, students can be more receptive to 

content and will likely recall more information when asked in a future learning 

experience.  

Comprehension and Retention 

It is a responsibility of both administrators and teachers to ensure a student 

experiences a smooth transition into the university atmosphere (Lau, 2003).  Research has 

shown that many students enter college with a lack of comprehension ability (Taraban, 

Rynearson, & Kerr, 2000).  Comprehension is an ability often overlooked when 

designing college-level academic lesson plans and activities.  Today’s professional world 

places demands on employees that are more easily achieved if their comprehension skills 

are higher (Williams, Ari, & Santamaria, 2011).  Too often, professors and teachers do 

not have the time to assess comprehension skills of students entering the college-level 

classroom, and this wide variation in initial ability has a strong impact on student 

performance (Sherfield, Montgomery, & Moody, 2005).  Students are becoming more 

aware of their own comprehension abilities, which relates to academic performance in 

that students are learning new ways to support their own learning styles (Taraban et al., 

2000). 

An important consideration for introducing new material in a college-level 

classroom is providing the material in a manner that allows students to succeed, 

regardless of their current level of reading comprehension.  Taking note of the prior 

experience of students is a way teachers can provide avenues of learning that are 
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conducive to efficient learning and retention (Lei et al., 2010).  Group learning and 

interaction is a process that allows for students of various academic and comprehension 

levels to share knowledge, allowing for deeper connections with both content and the 

learning environment (Goldenberg, 1992).  This concept also allows students to act as 

instructors to one another, which supports the development of individual ownership of 

the learning process (Lei et al., 2010, Gourgey, 1998).  

The use of learning aids and study guides has attributed to learning environments 

that support comprehension and retention (Khogali, Laidlaw, & Harden, 2006).  Prior 

knowledge in software has been described as an attribute that is rarely accounted for 

during lesson planning (Lei et al., 2010).  The use of textbooks as learning aides is an 

important consideration.  Often, college students are required to purchase and use high-

level texts, and the variation in comprehension skills among students makes the text less 

effective for some (Taraban, Tynearson, & Kerr, 2000).  Traditional textbook reviews are 

primarily focused on accuracy and content.  Durwin and Sherman (2008) found that not 

only does accuracy of content have a strong effect on its usefulness to the average 

learner, but also that readability and how much a student “likes” a book have a similar 

effect.  Publishers frequently offer chances for teachers that use textbooks to provide 

feedback on the content and delivery, so a textbook’s quality can improve over time 

(Durwin & Sherman, Ibid.). 

Creativity and Motivation 

Craft (1999) states that “Creativity is an essential life skill, which needs to be 

fostered by the education system(s) from the early years onward,” (p. 137).  A study 
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analyzing feedback from employers on recent graduates’ perceived competencies found 

creativity to be the most lacking attribute among the graduates assessed (Reid & Petocz, 

2004). 

In a study involving the instruction of technology to students, four teachers found 

that it was pertinent to rely less on “algorithmic approaches” and more on problem-

solving abilities if creativity within technical instruction is to be cultivated (Rutland & 

Barlex, 2008).  In this study, as can be expected in most public education settings, 

students exhibited a wide array of core self-motivation and creativity.  Numerous and in-

depth frameworks for differentiated instruction exist for secondary education, and many 

are successful due to the strict application of required curriculum.  Removal of traditional 

extrinsic physical motivators such as parents, friends, and mentors combined with the 

introduction of a perceived personal and academic freedom makes such frameworks less 

applicable to the post-secondary arena.  Studies have shown that learners without 

extrinsic motivation perform at a higher level when differentiation, ownership, and 

relevance are addressed as part of the content delivery (Zemke & Zemke, 1988).  

Students that understand why they are learning specific technical skills are more likely to 

feel empowered and find new and innovative ways to apply those skills within the 

context of the learning goals. 

Student motivation is paramount to success within the post-secondary academic 

environment.  While some would conclude that it is the responsibility of the student to 

conjure intrinsic motivation to succeed, such motivation can and should be supported 

through progressive teaching methods.  In a repeated study performed in his classroom, 

Sass (1989) concluded that eight characteristics of teachers are most recognized and 



	   28	  

appreciated by the student, leading to increased intrinsic motivation: Enthusiasm, 

relevance, appropriate difficulty level, active involvement, organization, variety, rapport, 

and use of appropriate examples. 

Four of the eight factors suggested by Sass (Ibid.) are paramount for building the 

foundation of an interactive, positive, learning experience as it relates to a technical 

studio course: Enthusiasm, relevance, appropriate difficulty level, and active 

involvement.  Enthusiasm refers to the instructor’s energy level, and the level of 

excitement the general teaching style generates.  Enthusiasm, as a motivator, would be 

more important in a general education setting, such as a lower-level post-secondary 

introduction class where students were not motivated by the value of the content.  

Conversely, in a motivational atmosphere, a student will be more inclined to perform 

beyond the technical competency area of learning and begin to display intangible learning 

traits such as critical thinking and interpersonal team building.  Relevance allows course 

content to be applicable to the learner’s academic and career goals.  Appropriate 

difficulty level simply requires the course content to be differentiated and catered to the 

level of the student’s skill and knowledge level.  Actively involved students are more 

likely to feel the sense of empowerment necessary for a positive learning experience. 

These are the foundations for implementing a project-based learning approach to the 

course content.  Seemingly simple, the correct combination of these factors can greatly 

influence the level of motivation, efficiency, and global application of desired skillsets.  

Studies have shown that fostering creativity within learning requires an 

environment that is social, situated, and interactive. (Lave & Wenger, 1991; Wenger, 

1998).  Theory, talent, and creativity are three pillars of the successful design student.  At 
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one time, creativity was a soft skill that was either owned or not owned, according to the 

observer.  Design agencies hired and fired based on this immeasurable skill – it was 

either present in portfolio and work or it was absent.  While creativity may seem to some 

as the most intangible of the three, in reality, even if it is not inherent in one’s makeup, it 

can be harnessed, if not learned.  Haseeb (2011) believes promoting creativity should be a 

purposeful process within a workflow.  Creativity is the result of an applied four-step 

process: preparation, incubation, illumination and verification (Sullivan, 1987).  The 

preparation phase can be best described as the simple application of knowledge without a 

true “goal” in mind.  For the interior design student, it might be working with new 

materials and colors or honing hand-rendering skills.  Incubation is a sometimes 

conscious, mostly subconscious phase where ideas are forming and growing within the 

designer’s mind.  Illumination is the “aha” moment when the idea crystallizes in his or 

her mind, and verification is the fruition of the idea.  A teacher’s role in encouraging 

creativity has changed as technology has evolved, and distinct teaching traits have been 

assigned to a creative learning environment.  The relationship between the instructor and 

students was found to have a strong influence on the creative output potential within a 

classroom (Chambers, 1972).  It was found that teachers who acted more as a facilitator 

and leader (and less the all-knowing expert) were more likely to engage students in 

highly creative situations (Edwards, 2001). This creative process can be nurtured within 

the construct of a motivational learning environment; more specifically, within a 

constructivist learning environment.   
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CHAPTER III 

METHODOLOGY 

Overview 

This study employed an experimental approach to identify individual retention 

skills of undergraduates using BIM software (AutoDesk Revit).  It utilizes two main 

learning theories, intertwined with Lang’s (2006) model of Limited Capacity Information 

Processing.  A behaviorist approach was used for a Control group, while a constructivist 

approach was used for an Experimental group.  This comparison of teaching 

methodologies is important to the future of studio courses in the undergraduate setting 

which utilize software and technology, especially as technology advances and software 

becomes more powerful.  It will identify the effects that each teaching approach has on 

students’ ability to retain information, exhibit creativity, and display positive behavioral 

indicators while participating in the learning process.   

Below is a process chart showing a high-level view of the experiment. 
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Figure 2. Overview of the Experiment 

 

Trained	  observers	  monitor	  learning	  behavior	  and	  the	  researcher	  evaluates	  the	  drawings	  
for	  accuracy	  and	  creativity.	  

Both	  groups	  return	  two	  weeks	  later	  to	  participate	  (separately)	  in	  a	  learning	  session	  that	  
requires	  each	  participant	  to	  create	  a	  second	  drawing	  using	  only	  retained	  information	  

from	  Session	  #1	  and	  core	  environmental	  attributes	  of	  each	  methodology.	  

Trained	  observers	  monitor	  learning	  behavior,	  and	  the	  researcher	  evaluates	  the	  
submissions	  for	  accuracy	  and	  creativity	  	  

Both	  groups	  attend	  learning	  sessions	  (separately)	  designed	  using	  either	  the	  behaviorist	  
or	  constructivist	  teaching	  methodology,	  where	  BIM	  drawings	  are	  created	  by	  each	  

participant.	  

The	  researcher	  forms	  two	  similar	  groups,	  one	  Behaviorist	  (Control)	  and	  one	  
Constructivist	  (Experimental)	  containing	  17	  participants	  in	  each	  

Students	  are	  recruited	  for	  the	  study	  and	  complete	  a	  survey	  containing	  demographic	  and	  
academic	  information.	  
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Boghossian (2006) suggests that a behaviorist learning environment is appropriate 

for content delivery in which no subjective or creative element of the environment or 

content is expected or interpreted.  For technical assessment, the behaviorist teaching 

method has been historically successful.  In the case of teaching software in a studio 

setting, students can be given assignments that are aimed at technical skill building, and 

the objectivity of technical assessment allows a teacher to analyze this student work with 

a general rubric.   

Students wishing to find employment in the Interior Design field, or any creative 

field, are increasingly required to exhibit far more than technical ability.  Creativity, 

critical thinking, and interpersonal skills have become as important as knowing software 

and digital processes.  Beyond technical ability, CIDA (2011) requires that: 

Entry‐level interior designers need to apply all aspects of the design process to 

creative problem solving.  Design process enables designers to identify and 

explore complex problems and generate creative solutions that support human 

behavior within the interior environment. 

The CLE is a technology-based academic environment where social interaction, 

dynamic inquiry, and metacognitive reflection are paramount to the student’s success 

(Sultan et al., 2011).  Within this type of environment, students have a greater chance of 

employing their own creative abilities, coupled with learning and retaining course 

outcomes.  In today’s studio classroom, teachers are challenged to find ways of building 

creative processes and teaming skills into a curriculum that has been traditionally taught 
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from an objective standpoint.  This study is being conducted to explore methods of 

teaching these subjective skills while preserving the integrity of the core curriculum. 

Behaviorist Modules 

 

Figure 3. Overview of the Learning Sessions for the Behaviorist (Control) Groups 

 

Currently, software instruction within the Interior Design curriculum at IUP is 

taught primarily with a behaviorist approach.  An impact designed within the experiment 

is that actual curriculum practiced at the university is the basis for the experiment’s 

instructional content.  As such, the Control group was provided instruction that mimics 

the current teaching method.  This module was designed to include a step-by-step, paper-

based tutorial that will take the group members through a technical learning process.  The 

Control group participated in two learning sessions.  In Session 1 of the behaviorist 

module, participants used the tutorial to create an architectural drawing.  In Session 2, 

participants were asked to repeat the procedure (executing the same drawing) without the 

tutorial, provided only with general technical requirements.  Behaviorist practices are 

based on individual response, and for this reason, limitations were implemented that align 

themselves with typical behaviorist methodologies.  First, the Control group did not have 

Behaviorist	  Session	  1	  

• Participants	  are	  given	  a	  step-‐by-‐step	  
tutorial	  walking	  them	  through	  the	  
process	  for	  creating	  a	  BIM	  drawing.	  	  
They	  are	  asked	  to	  complete	  the	  
tutorial	  within	  a	  two-‐hour	  time	  limit	  

Behaviorist	  Session	  2	  

• Participants	  are	  asked	  to	  complete	  a	  
second	  drawing	  without	  the	  tutorial	  
learning	  aid.	  	  Instead,	  a	  list	  of	  general	  
guidelines	  is	  provided.	  	  They	  are	  
asked	  to	  complete	  the	  drawing	  within	  
the	  same	  two-‐hour	  time	  limit..	  	  	  
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the ability to engage in discussion with other participants in the session.  Second, no 

outside references or access to the Internet were permitted.  This allowed the researcher 

to analyze the success of each participant’s project solely on the individual’s ability to 

follow instructions, retain written information, and submit evidence of each. 

Constructivist Modules 

 

Figure 4. Overview of the Learning Sessions for the Constructivist (Experimental) Group 

 

The Experimental group participated in two sessions where a constructivist 

method was applied.  The physical product of these sessions was comparable to that of 

the Behaviorist modules, with the exception of the content delivery and learning process.  

During the beginning of each constructivist session, the instructor provided a short 

demonstration of the tools (within the software) that participants would be using to create 

their individual drawings.  Students were able to take notes, and then allowed to begin 

working on their drawing.  Unlike the behaviorist modules, students were able to interact, 

ask each other questions, and provide feedback.  This open format without particular 

direction was designed to place more responsibility for learning on the shoulders of the 

participants rather than relying so heavily on provided documentation and directions.  

Constructivist	  Session	  #1	  

• Participants	  are	  given	  a	  15-‐minute	  
introduction	  to	  the	  BIM	  software,	  and	  
then	  provided	  with	  general	  guidelines	  
for	  a	  drawing.	  	  They	  are	  asked	  to	  
complete	  the	  drawing	  within	  a	  two-‐
hour	  time	  limit.	  

Constructivist	  Session	  #2	  

• Participants	  are	  asked	  to	  complete	  a	  
second	  drawing	  without	  the	  software	  
introduction	  learning	  aid.	  	  They	  are	  
provided	  only	  the	  list	  of	  general	  
guidelines	  (from	  Session	  1).	  	  They	  are	  
asked	  to	  complete	  the	  drawing	  within	  
the	  same	  two-‐hour	  time	  limit.	  	  	  
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Like the Behaviorist group, the participants of the Constructivist group submitted their 

design product at the end of the session for technical assessment. 

Sampling and Volunteer Recruitment 

This study required nonprobability purposive and volunteer sampling to procure 

appropriate participants.  The study was open to undergraduates at IUP who were (1) 

enrolled in the Interior Design program, and (2) have completed at least one semester of 

computer-aided drafting software instruction.  Students who have completed INDS 218 – 

Drafting for Construction II at Indiana University of Pennsylvania, for example, were 

prime candidates.  This prerequisite was necessary to ensure the experiment could run 

without the need for instruction in the most basic context.   

The researcher personally visited various Interior Design classes and announced 

her intention to recruit students.  Once in front of the class, a prepared script was 

followed closely (Appendix A). 

Everyone in the class was given an individual sign-up sheet (Appendix C – 

Volunteer Sign-Up Sheet) during the announcement so that no student felt influenced to 

participate based upon his or her peers.  If the student did not wish to participate, they 

simply handed in a blank form.  Those who did wish to participate submitted their name, 

IUP email address, and preferred dates for participation.  Additionally, volunteers were 

given an informed consent form (Appendix B – Informed Consent Form) for review, and 

asked to sign a consent form (Appendix D – Voluntary Consent Form). 

Students were aware that dinner would be provided, simply for their participation. 

This incentive was offered to compensate the individuals for time spent during the 
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modules, and was not intended to influence behavior or work ethic within the 

instructional modules.  All participants were enrolled in the Interior Design program, and 

therefore students and, in some cases, advisees of the researcher.  No other incentives 

were provided; participants were not awarded extra-credit towards any interior design 

course. 

Learning Group Assignment 

Participants who volunteered for the study were each given a survey prior to the 

module delivery that consisted of questions regarding demographic data, level of 

academic progression, GPA, and prior knowledge within the context of the instructional 

content to be delivered.  Additionally, participants answered questions about their self-

efficacy, experience, and comfort level with BIM software as well as technology in the 

classroom.  This information was pertinent to accurately balance the two subgroups with 

participants that have a varying range of experience.  The survey was sent by email via 

SurveyMonkey.com after students submitted the volunteer applications.  This survey can 

be found in Appendix E – Pre-Session Demographic Survey. 

When a volunteer submitted a survey, it was reviewed by the researcher.  

Participants were assigned to groups using paired matching to assure reasonably similar 

groups.  This pairing was based on their year in school and previous completion of a 

course which utilized a specific drafting software, AutoCAD.  The combination of this 

data placed each volunteer in a classification of either “Upper Division” or “Lower 

Division.”  “Lower Division” participants were typically sophomore level students who 

were familiar with AutoCAD but no other design software.  The label “Upper Division” 
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was applied to participants at the junior and senior level, who by nature of their 

progression through the Interior Design curriculum had added experience in multiple 

architectural design software packages.  Volunteers from these two classifications were 

dispersed as equally as possible between the Control and Experimental groups.   

Two groups were formed consisting of approximately twenty (20) undergraduates 

each: one group was taught using a behaviorist approach (Control group) and one group 

using a constructivist approach (Experimental group).  Once the Control group and 

Experimental group were assigned participants, each participant was assigned an 

identification number, Crimson 1 through Crimson 25 for the Control group, or Slate 1 

through Slate 25 for the Experimental group.  The assignment of the identification 

numbers was important for both data tracking and for confidentiality and anonymity.  

Further detail regarding confidentiality and privacy protection can be found on page 41.     

As part of the volunteer sign-up process, students were asked to indicate preferred 

dates for participation.  These data (participants’ selected dates) were used to determine 

the most convenient dates for the study to take place.  Once the four dates were 

determined (two for the Control group and two for the Experimental group), two emails 

were sent – one to each group, notifying each of the suggested dates for the two sessions.  

Volunteers were asked for a reply confirming acceptance of the dates or expressing 

concern or the inability to attend.         

Behaviorist (Control) Group – Learning Sessions 

The Control group engaged in learning sessions on Thursday, April 19, 2012 and 

two weeks later on Thursday, May 3, 2012.  In preparation for the first learning session, 
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the researcher had labeled workstations with identification numbers corresponding to the 

participants involved in that particular session.  As participants arrived to the first 

session, they were given a small card with their identification number, and asked to sit at 

the corresponding workstation for the duration of the session.  During the first session, 

each participant in the Control group (Group Crimson) was given a printed copy of a 

tutorial for drawing a basic commercial building.  This group did not receive any verbal 

instructions.  The tutorial can be found in Appendix F – Step-by-Step Tutorial.  

Participants were instructed to electronically draft the commercial building model using 

AutoDesk Revit and the supplied tutorial.  They were asked to notify the instructor when 

finished, at which time the project was saved to a folder on the participant’s computer 

and the printed tutorial was handed in.  After finishing, each participant was handed a 

printed copy of a post-session survey to be completed prior to leaving.  This survey 

contained questions about the participant’s feelings about the session, including whether 

or not he or she felt:  1) the module was difficult, 2) comfortable using the software as a 

result of the session, 3) that he or she had learned a great deal as a result of the session, 4) 

that he or she could use the skills learned in a future project, 5) the skills learned during 

the session would be applicable in another class, and 6) the skills learned during the 

session would be applicable in a future or current job.  This survey can be found in 

Appendix I – Post-Session Survey.  This session was slated to last no more than two 

hours, and most participants were finished prior to the two-hour mark.  Prior to leaving 

the session, participants were reminded of the second session date and time.   

During the second session, the instructor followed the same preparation steps as 

the first session, and the participants were instructed to draw the same commercial 
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building as was drawn in the first session.  In this session, however, the students were not 

given the step-by-step tutorial.  Rather, the instructor provided a whiteboard with general 

requirements, such as the size of the building, minimum number of windows, interior 

specifications, and a handful of other guidelines.  These specific guidelines can be found 

in Appendix G – Building Guidelines.  Participants were asked to notify the instructor 

when finished, at which time the project was saved to a folder on the participant’s 

computer.  After finishing, each participant was handed a printed copy of the post-session 

survey, identical to the one completed after Session 1, to be completed prior to leaving.   

Constructivist (Experimental) Group – Learning Sessions 

The Experimental group also engaged in learning sessions two weeks apart on 

Sunday, April 22 and Sunday, May 6, 2012.  To ensure a comparable environment and 

process, the researcher used the same preparation techniques including labeled 

workstations and participant identification numbers.  During the first session, the 

instructor presented a twenty-five minute introductory lesson on AutoDesk Revit, 

teaching the use of basic tools and functionality that would be necessary to draw a simple 

commercial building.  After the lesson, participants had 10 minutes to ask general 

questions.  At this time, the instructor revealed a whiteboard with general requirements 

for the drawing, identical to the guidelines given to the Control group in their second 

session (Appendix G – Building Guidelines), and instructed the participants to complete 

the drawing using the guidelines.  As this group was engaged in a constructivist learning 

environment, they were allowed to talk with each other, ask questions (only to other 

participants, not the instructor), and provide feedback and guidance to one another.  

While this interaction was permitted, each participant had to complete his or her own 
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drawing, and at no time was one student allowed to physically aid another in the drawing 

process.  Trained observers ensured the integrity of the individual work.  They were 

asked to notify the instructor when finished, at which time the project was saved to a 

folder on the participant’s computer.  After finishing, each participant was handed a 

printed copy of the post-session survey, identical to the one given to the participants in 

the Control group, to be completed prior to leaving.  This session was slated to last no 

more than two hours, and most participants were finished by one hour of studio time.  

Prior to leaving the session, participants were reminded of the second session date and 

time.   

During the second session, the instructor followed the same preparation steps as 

the first session, and the participants were instructed to draw the same commercial 

building as was drawn in the first session.  In this session, however, the students were not 

given the introduction lesson by the instructor.  Rather, the instructor provided the 

whiteboard with general requirements, identical to the guidelines in the first session 

(Appendix G – Building Guidelines).  Participants were asked to notify the instructor 

when finished, at which time the project was saved to a folder on the participant’s 

computer.  After finishing, each participant was handed a printed copy of the post-session 

survey, identical to the one completed after Session 1, to be completed prior to leaving.   

Learner Observation 

            An important factor in the collection of data was the role of the independent 

observers who monitored all instructional modules.  Observers were recruited based on 

their education and/or experience in online and digital learning.  Most of the observers 
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were colleagues from IUP in the Communications Media Department.  The researcher, 

with guidance and direction from her dissertation committee, developed a printed tool for 

recording visual indications of mood changes, stress, and other positive and negative 

signs of behavioral changes exhibited by participants during the learning sessions.  Four 

observers were scheduled for each learning session, which allowed for focused attention 

on no more than five students for the duration of the session.  Prior to the session, each 

observer was educated on the use of the recording tool, as well as the visual indications 

and how to determine when they should be coded.  Some of the visual indications 

included confusion, disruptive behavior (both positive and negative in nature), nervous 

behavior, body movement, among others.  A detailed description of these indications can 

be found in Appendix H – Learning Stress Observation Record.  This monitoring was 

helpful in developing a conceptual approach to the differences that are present between a 

behaviorist and a constructivist environment.   

Confidentiality, Treatment of Subjects, and Data 

Data from this study were extracted from physical surveys completed by the 

participants as well as observational data sheets from both learning sessions. Any 

information procured from paper-based surveys was immediately entered by the 

researcher into an electronic database (a Microsoft Excel spreadsheet), and checked for 

accuracy, at which point the paper copies were destroyed by the principal investigator.  

The spreadsheet contained student names (Column A) and corresponding student 

identification numbers (Column B).  The Names column (Column A) was temporary – its 

only purpose was to match students to their identification numbers for both sessions.  
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When both sessions were completed and the data were entered, the principal 

investigator deleted Column A of the spreadsheet in its entirety, thereby removing the 

student names from the data and eliminating any connection between the student and data 

stored.  This aided in protecting the student’s confidentiality.  All data were stored 

consistent with Indiana University of Pennsylvania’s subject and data protection policies. 
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CHAPTER IV  

RESULTS  

Overview 

This chapter will analyze and discuss data drawn from surveys and observational 

recordings during four learning sessions.  This study compared two teaching 

methodologies, behaviorism and constructivism, to explore the impact each has on 

student performance in an Interior Design studio course.  Two groups of volunteer 

learners were formed, and each were engaged in learning sessions that used either a 

behaviorist or a constructivist approach.  

The first group of learners (the Control group) participated in two learning 

sessions in which the instructor used a behaviorist approach and methodology.  The first 

session included a step-by-step tutorial that was intended to walk the students through the 

process of creating an electronic drawing using Building Information Modeling (BIM) 

software.  In order to gauge retention, the second session was identical but without the 

tutorial.  Students were required to rely only on recalled knowledge for this session.     

The second group of learners (the Experimental group) participated in two 

learning sessions where the instructor employed a constructivist approach.  In the first 

session, students were given a short introduction to the BIM software, and were allowed 

to devise and implement their own method to create the end product, which was specified 

using general guidelines around the requirements of the drawing.  The second session 

was identical to the first, excluding the short software introduction.  Like the Control 

group, this was to gauge retention levels. 
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Prior to the study, participants were asked to submit demographic and academic historical 

data via a pre-session survey.  The survey consisted of questions about age, grade point 

average, comfort utilizing technology, experience with studio classes, and experience 

with software instruction.  Below is a table summarizing this information. 

 

Table 1  

Comparisons of Mean Scores of Group Demographics 

 
Variables 
 

Behaviorist 
(Control) 

Constructivist 
(Experimental) 

Age 21.00 20.76 

GPA 3.11 3.09 

Comfort level with technology 4.71 4.71 

Prior use of software in undergraduate courses 1.82 1.76 

Completion of undergraduate studio courses 2.53 3.00 

   

Note: N = 34 

In order to produce valid data, it was a goal to ensure that both groups of students 

contained participants very closely related in these key characteristics.  Participant ages 

between the Behaviorist (Control) group and Constructivist group were very similar.  The 

Mean score for the Behaviorist group was 21.00 (meaning 21 years of age), and the Mean 

score for the Constructivist group was 20.76.   
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Grade point averages (GPA) for each participant were measured at the time of the 

first learning session, and were also similar.  The Behaviorist group produced a Mean 

score of 3.11 (out of a 4.0 GPA scale), with the Constructivist group scoring slightly 

lower at 3.09. 

Scores for the participants’ comfort with technology (survey data prior to study) 

were identical with a Mean score of 4.71 (meaning that the average participant responded 

by saying that he or she feels very comfortable using technology, and uses it often).  Also 

nearly identical were the Mean scores for the number of prior courses completed that 

taught software as the primary core of the class.  Behaviorist participants scored a Mean 

1.82 and the Constructivist participants scored 1.76, which means that the average 

participant in both groups responded by saying that he or she has taken between 6 and 10 

courses that had taught software prior to the study.  Data about prior studio course 

participation was also similar with the Behaviorist group scoring a Mean 2.53 and the 

Constructivist group a 3.00, which means the average participant had completed between 

6 and 10 studio-based courses prior to the study.  

 

Research Question 1 

 What is the effect of instructor interaction on a student’s ability to apply and retain 

knowledge in a studio setting, as measured by rubrics that assess accuracy?   

The first research question was developed to compare and measure the effects of 

an instructor’s role in both a behaviorist and constructivist setting.  This exploration 
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focused primarily on students’ ability to create technically accurate electronic renderings 

within a specified time limit, with and without a learning aid. 

 

Table 2 

Comparisons of Group Scores in Evaluation Accuracy 

Variables 

 

Behaviorist 

(Control) 

Constructivist 

(Experimental) 

Mean Score of Session 1 – Evaluation Accuracy 4.00 4.71 

Mean Score of Session 2 – Evaluation Accuracy 4.12 4.59 

Difference of Mean Score from Session 1 – Session 2 -0.12 0.12 

Standard Deviation of Session 1 1.17 0.47 

Standard Deviation of Session 2 0.99 0.79 

Difference of Standard Deviation from Session 1 – Session 2 0.18 -0.32 

Note: N = 34 

*Evaluation Accuracy was measured on a scale of 1-5, 1 being Not at all Accurate and 5 

being Extremely Accurate. 

 

H1.1 - For Session 1, the Behaviorist group’s Evaluation Accuracy scores will be 

higher than the Constructivist group’s scores. 

The behaviorist methodology uses direct instruction and repetition to aid 

information processing.  In this light, the participants were asked to use a step-by-step 

tutorial to create their drawings (each participant had the same tutorial with the same end 
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product).  As a result, it was assumed that the accuracy level of specific drawing elements 

explained in the tutorial would be higher than the Constructivist group results, as the 

constructivist methodology uses a more subjective approach to information processing.  

Additionally, the Constructivist group participants were provided instructions that were 

far more general in nature. 

Utilizing a t-test, (t = -2.30, df = 32, p = 0.03), results indicated the hypothesis 

was not held and the prediction was reversed.  During Session 1, the group score in 

Evaluation Accuracy was significantly lower for the Behaviorist (Control) group 

compared to the Constructivist (Experimental) group.  This reversal in outcome could be 

the result of multiple factors.  The introduction that was given in the constructivist 

learning Session 1 may have been a catalyst for understanding that provided a foundation 

for the performance of the group.  In the constructivist approach to teaching, the use of a 

general overview is used to better equip a variety of learning styles exhibited by students, 

and may contribute to a higher level of learner engagement.  It could be argued that the 

ability for students to work with each other and provide feedback allowed for a learning 

environment that included peer review and editing phases.   

 

H1.2 – For Session 2, the Behaviorist group’s Evaluation Accuracy scores will be 

lower than the Constructivist group’s scores. 

The Behaviorist group’s mean score improved slightly, though still not to the 

level of the Constructivist group.  Shepard (2000), lists the six key components of the 

behaviorist teaching method, the last of which is that “motivation is external and based 
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upon positive reinforcement of many small steps.”  This external motivation took the 

form of a walkthrough tutorial provided to the Behaviorist participants in Session 1. 

Since the learning sessions were designed to assess retention when comparing a 

behaviorist method with a constructivist method, neither group had access to the learning 

aids of the project for Session 2.  This included the step-by-step tutorial for the 

Behaviorist group and the introductory presentation for the Constructivist group.  It was 

expected that the Constructivist group would score higher because of learning the 

material through their own exploration. 

Utilizing a t-test, (t = -1.53, df = 32, p = 0.14), the Behaviorist (Control) group 

Evaluation Accuracy score was lower than the Constructivist (Experimental) group score 

during Session 2, as predicted.  These results were not significant (p = 0.05).  While both 

groups were without the learning catalyst, the core nature of the learning environment 

likely had an effect on outcomes in each Session 2.  As in Session 1, the Behaviorist 

group was required to work alone and rely on recall of learned information from Session 

1, whereas the Constructivist group could use prior knowledge as well as the peer 

learning community.  The Evaluation Accuracy rating, especially for Session 2 of each 

group, was applied to a drawing that both groups were given general requirements for 

producing.  Both groups’ second sessions were more reliant on retention of knowledge 

learned from the first session.  In the behaviorist approach, an emphasis was placed on 

information reiteration in order to assess learning, and in Session 1, the Behaviorist 

participants relied on a step-by-step tutorial that assisted in producing the first drawing.  

These instructions on how to create a product only provided indirect instructions on how 

to utilize the software, so the removal of the tutorial left students at a potential 
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disadvantage for Session 2, where the software would have to be used without 

instructions. 

 

H1.3 - The Behaviorist group Evaluation Accuracy scores will decline from Session 1 

to Session 2.  

This hypothesis was derived from the expectation that knowledge of the software 

would not be as easily comprehended in the Behaviorist group’s first session due to the 

structure of the behaviorist learning environment, and would result in a decrease in 

technical accuracy.  Since the Behaviorist group’s software instruction was built into the 

tutorial, the reliance on memory of linear processes during Session 2 would make 

recollection difficult. Without the ability to work in peer groups and attain feedback, it 

was assumed that the achievement scores would decrease.    

A t-test was conducted, (t = -0.34, df = 16, p = 0.74), and the results determined a 

slight reversal of Evaluation Accuracy scores for the Behaviorist (Control) group 

between sessions.  There was a change in the Mean score from 4.00 to 4.12, however, 

these findings were not significant (p = 0.05).  This reversal could be the result of prior 

knowledge having a more positive effect than expected on the outcome of the group in 

session two.  Additionally, Session 1 included a built-in familiarization of the software, 

whereas the participants in Session 2 were not learning new software and relied on prior 

experience with the material.  The natural environment of the behaviorist approach 

focused more on helping the learner to produce an end result that was exactly the same as 
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the other students in Session 1, but the second session provided a general requirement list 

that was that was more achievable with some prior knowledge of the software.   

 

H1.4 - The Constructivist group Evaluation Accuracy scores will increase from 

Session 1 to Session 2.  

This hypothesis was created based on the assumption that students in the 

Constructivist group would exhibit a stronger retention of information in the second 

session as a result of the nature of the constructivist learning approach.  The 

constructivist method promotes group interaction and higher-order thinking, and given 

prior knowledge learned in Session 1, the guidelines provided for the end product in 

Session 2, and the ability to work with other students within the learning session, 

expectations were that the Mean score would increase between Sessions 1 and 2.  

In order to calculate results, a t-test was used (t = 0.52, df = 16, p = 0.61).  The 

results indicated a reverse in the prediction.  There was a slight drop in the Mean score 

from 4.71 to 4.59, however, the findings are not significant (p = 0.05).  These results are 

based on a naturally subjective assessment of general requirements.  Students 

participating in both Session 1 and Session 2 of the Constructivist group were working 

with these requirements and likely created end products that were either slightly or 

significantly different between the sessions.  This natural modification was expected as 

the result of a more open learning environment and learning goals.  The constructivist 

approach (in this case) places less significance on individual outcomes as it does for 

general achievement as the result of a learning community approach in the classroom.  
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Since the results declined, but were still in a high achievement category, the difference is 

not significant. 

 

Table 3  

Comparisons of Group Scores in Completion Time 

 
Variables Behaviorist 

(Control) 
Constructivist 
(Experiment) 

                        Mean Score of Session 1 – Completion Time 57.24 49.53 

Mean Score of Session 2 – Completion Time 35.24 31.00 

Difference of Mean Score from Session 1 – Session 2 22.00 18.53 

Standard Deviation of Session 1 15.14 9.20 

Standard Deviation of Session 2 8.20 9.51 

   Difference of Standard Deviation from Session 1 – 
Session 2 

6.94 -0.31 

  

Note: N = 34 

*Completion Time was measured in minutes and seconds (30.30 = 30 minutes and 30 

seconds). 

 

H1.5: For Session 1, the Behaviorist group’s Completion Time will be higher than the 

Constructivist group’s. 

The Behaviorist group, in Session 1, was given a tutorial to follow for completion 

of the project.  This tutorial was identical for every student in the group and, as a result, 
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was predicted to take about the same time to complete for everyone.  The Constructivist 

group was given an introduction to the software, and left to create their own product 

based upon general guidelines.  This open format for the classroom was expected to 

widely vary the scores in Completion Time for each individual learner, from the 

perspective of when each felt his or her project was complete enough to turn in.  

A t-test was conducted (t = 1.78, df = 32, p = 0.08), and the results indicated a 

slightly greater Completion Time from the Behaviorist group to the Constructivist Group. 

The Behaviorist group’s Completion Time mean score during Session 2 was 57.24, which 

was higher than the mean score of the Constructivist’s Group of 49.53.  Although these 

results were not statistically significant (p = 0.05), they indicate an almost eight minute 

increase between the groups for Session 1.  The results of this test were as expected, 

though the difference was not statistically significant due to the large Standard Deviation, 

particularly in the Behaviorist group’s Session 1 (sd = 15.14).  A strong indication from 

other data leads to the probability that the increase in embellishments (to be discussed 

later in this chapter) by the Constructivist group added to the overall Completion Time.   

 

H1.6: For Session 2, the Behaviorist group’s Completion Time will be higher than the 

Constructivist group’s time of completion. 

Unlike the first session, both the Constructivist group and the Behaviorist group 

worked from general guidelines in order to complete the second session, which made the 

learning environments more similar during the second session.  This alignment allowed 
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data to accurately indicate retention levels and recall ability for both groups through 

Completion Time and accuracy statistics. 

In order to calculate results, a t-test was used (t = 1.40, df = 32, p = 0.17).  The 

results were predicted by the hypothesis, though not statistically significant.  The 

Behaviorist group’s Completion Time mean score during Session 2 was 35.24, which was 

higher than the mean score of the Constructivist’s Group of 31.00. There was less than a 

five-minute difference between the groups for their recorded Completion Time score in 

Session 2.  The level of embellishing and creativity employed between both groups likely 

had an effect on the Completion Time of both groups being similar for Session 2.  

Additionally, the Behaviorist group was required to work individually, which likely 

accounted for the higher Completion Time when compared with the Constructivist group. 

 

Research Question 2 

 Does the instructor’s choice of a constructivist approach versus behaviorist impact 

students’ behavior during and attitude towards studio-based learning, as measured by 

student surveys, observed learning indicators, and creative output? 

The second research question was developed to compare and measure the effects 

of an instructor’s choice of teaching methodology.  For this research question, the 

researcher focused on observed levels of stress, participants’ reported levels of learning, 

difficulty, and confidence, as well as their evaluated score of Design Embellishment. 
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Table 4 

Comparisons of Group Scores in Total Stress 

 
Variables 
 

Behaviorist 
(Control) 

Constructivist 
(Experimental) 

Mean Score of Session 1 – Total Stress 12.76 9.76 

Mean Score of Session 2 – Total Stress 18.29 6.29 

Difference of Mean Score from Session 1 – Session 2 -5.53 3.47 

Standard Deviation of Session 1 6.67 5.11 

Standard Deviation of Session 2 10.74 4.58 

Difference of Standard Deviation from Session 1 – 
Session 2 

-4.07 0.53 

 

Note: N = 34 

*Total Stress was measured using indicators of learning stress. A  score of 10 indicates 

that the group exhibited an average of 10 signs of stress per participant throughout the 

session. 

 

H2.1: For Session 1, the Behaviorist group’s Total Stress scores will be higher than 

the Constructivist group’s scores.   

This hypothesis was derived from an analysis of the timeline of events within 

each of the sessions.  Both the Behaviorist group and the Constructivist group were 

required to learn the software as well as create a product during the same session.  The 

difference between the two is that the Behaviorist group was engaged in a process where 

they were learning the software as a result of the step-by-step tutorial, whereas the 
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Constructivist group was given a more general software lecture at the beginning.  It is 

likely that cognitive load would have been higher during the Behaviorist session since the 

Behaviorist participants learned the software and created their drawings simultaneously, 

whereas the Constructivist group learned the software and created their drawing 

separately.  This increase in cognitive load may have directly influenced learning stress 

levels. 

Utilizing a t-test (t = 1.47, df = 32, p = 0.15), the results indicate a higher Total 

Stress score for the Behaviorist (Control) group than Constructivist (Experimental) 

group.  While the Mean score for Behaviorist was 12.76 and the Mean score for 

Constructivist was 9.76, the results are not significant to indicate a strong increase (p = 

0.05).  While not significant, the increase in stress is an indicator of potentially reduced 

comprehension, which was found to be significant in Hypothesis 2.2.  The Behaviorist 

stress score, with a Standard Deviation of 6.67, may have been reduced from its potential 

level by the fact that participants were given more detailed instructions than in the 

Constructivist group, which had a Standard Deviation of 5.11.  The disbursement of 

specific content and specific instructions is a core value of the behaviorist approach to 

teaching. 

 

H2.2: For Session 2, the Behaviorist group’s Total Stress scores will be higher than 

the Constructivist group’s scores.   

Referring to Hypothesis 2.1, it is likely that the Behaviorist group experienced a 

higher cognitive load in session one than the Constructivist group, which is often an 
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inhibitor to comprehension and/or retention.  While both groups were without their 

respective learning aids (Behaviorist group members were given a tutorial in Session 1, 

and Constructivist participants were given an introductory lesson) in Session 2, the 

format of the learning aid in Session 1 for the Behaviorist group may have contributed to 

a lack of comprehension.  Since it was a step-by-step tutorial, students were not required 

to learn the software application in a way that would allow them to devise a product from 

scratch.  

In order to calculate results, a t-test was used (t = 4.24, df = 32, p = 0.00).  The 

outcome was as predicted by the hypothesis.  The Behaviorist (Control) group Total 

Stress score for Session 2 (Mean = 18.29) were much higher than the Constructivist 

(Experimental) group score (Mean = 6.29).  Additionally, the findings were statistically 

significant (p = 0.05).  The Behaviorist group exhibited nearly three times the observed 

signs of stress as did the Constructivist group, which may have been influenced by the 

structure of the behaviorist learning environment in Session 1.  The behaviorist approach 

in this experiment placed a strong dependence on the tutorial in Session 1.  When asked 

to complete the same product in Session 2 without it, the lack of retention likely caused 

learning stress.  Additionally, unlike the Constructivist group in Session 2, the 

Behaviorist participants were required to work individually, and were consequently 

restricted to only their own knowledge to assist in completing the project. 
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H2.3: The Behaviorist group’s Total Stress scores will increase from Session 1 to 

Session 2. 

This hypothesis was generated from the assumption that the Behaviorist group 

retained less information presented in Session 1, and experienced exponentially more 

stress when asked to recall that information in Session 2.  The behaviorist methodology 

supports a more structured and preconceived format for content delivery, and students 

within this group are less likely to learn the basic tools within the software used to create 

their drawings.   

Utilizing a t-test, (t = -2.17, df = 16, p = 0.046), the prediction in the hypothesis 

was upheld.  The Mean Total Stress score for Session 1 was 12.76 and the Mean score for 

Session 2 was 18.29.  It was confirmed that students in the Behaviorist group experienced 

significantly increased stress levels in the second session.  Stress levels may have 

increased as a result of a decreased ability to recall information learned in Session 1.  As 

expected, the Behaviorist group was likely focused more on creating the product 

described in the tutorial than on learning the features of the software in Session 1.  As a 

result, when the Behaviorist group was not provided the step-by-step tutorial during the 

second session, learning stress increased. 

 

H2.4: The Constructivist group’s Total Stress scores will decrease from Session 1 to 

Session 2. 

The Constructivist group was required to learn the software without a tutorial, 

only a short introduction.  Consequently, it was the responsibility of the participants to 



	   58	  

decide how each would best be able to learn the software.  This hypothesis was created 

with the assumption that since the participants were at least partially responsible for the 

method in which each would learn the software, that retention levels would be higher and 

stress levels reduced.   

A t-test was conducted (t = 2.71, df = 16, p = 0.02), and the results indicated a 

statistically significant decrease in Total Stress scores for the Constructivist 

(Experimental) group from Session 1 to Session 2.  The Mean score for Session 1 was 

9.76, while the Mean score of Session 2 was 6.29.  The data support the hypothesis.  In a 

constructivist learning environment, learners engaged in an activity that involves 

comprehension and retention of content knowledge can exhibit reduced stress levels.  

Even with the removal of the learning aid, stress levels were significantly less in Session 

2 for the Constructivist group.  The open format of the learning environment also allowed 

for more creative licensing to be taken by each learner, and this freedom likely played a 

role in counteracting any stress that may have developed as a result of removing the 

learning aid. 
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Table	  5	  

Comparisons of Group Scores in Learned Valuable Skills 

 
Variables 
 

Behaviorist 
(Control) 

Constructivist 
(Experimental) 

Mean Score of Session 1 – Learned Valuable Skills 3.18 3.41 

Mean Score of Session 2 – Learned Valuable Skills 2.94 3.18 

Difference of Mean Score from Session 1 – Session 2 0.24 0.23 

Standard Deviation of Session 1 0.73 0.87 

Standard Deviation of Session 2 0.56 0.73 

Difference of Standard Deviation from Session 1 – Session 2 0.17 0.14 

 

Note: N = 34 

*Learned Valuable Skills was measured on a Likert scale of 1-5, 1 representing that no 

skills were learned and 5 representing that many skills were learned. 

 

H2.5: For Session 1, the scores on the Learned Valuable Skills measure for the 

Behaviorist group will be lower than for the Constructivist group.  

This hypothesis was derived from the idea that the learning experience of a 

student can have a direct effect psychologically on the student and whether he or she 

feels that the learning was successful.  The concept that formed this hypothesis centers 

around the ability for a constructivist environment to foster skills that go beyond the 
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standard academic content, including interpersonal skills, teamwork, peer feedback, and a 

general learning community atmosphere.   

Utilizing a t-test (t = -0.86, df = 32, p = 0.40), the results indicated some modest 

support for the hypothesis, but were not statistically significant.  The Mean score (3.18) 

for Learned Valuable Skills of the Behaviorist (Control) group was lower than the Mean 

score (3.41) for the Constructivist (Experimental) group in the first session.  This lack of 

significant difference could relate directly to whether or not the students (from either 

group) felt the project was difficult.  In fact, the easier that a learning objective is, the less 

likely a student is to feel skills were learned.  In this case, it is likely that neither group 

found the project difficult from a technical perspective, possibly as a result of a higher 

level of prior knowledge. 

 

H2.6: For Session 2, the scores on the Learned Valuable Skills measure for the 

Behaviorist group will be lower than for the Constructivist group.  

This hypothesis was derived from a similar concept discussed in Hypothesis 2.5, 

that the learning experience of a student can have a direct psychological effect on 

whether he or she feels that the learning was successful.  The inability for the students to 

rely on the learning aids afforded in Session 1 would make retention an important factor 

in Session 2.  The learning environment created from the constructivist approach may 

provide a greater pool of resources for the students to utilize in creating their drawings. 

In order to calculate results, a t-test was used (t = -1.06, df = 32, p = 0.30).  The 

findings, though not significant, were as predicted by the hypothesis.  The Mean score for 
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Learned Valuable Skills of the Behaviorist group (Control group Mean = 2.94) was lower 

than the Constructivist group (Experimental group Mean = 3.18).  Like Hypothesis 2.5, 

the difference between the Behaviorist group and the Constructivist group was not 

significant, though data still indicated that participants in the Constructivist group 

generally felt somewhat more successful in learning valuable skills during the learning 

session, and that both groups had an increase in perceived learning from one session to 

the next.  It could be argued that the removal of the learning aid forced more of an 

individual effort to complete the project, which may have resulted in an increased feeling 

of learning success. 

 

H2.7: The Behaviorist scores on the Learned Valuable Skills measure will not change 

from Session 1 to Session 2.  

The learning sessions for the Behaviorist groups were nearly identical in process 

between Sessions 1 and 2, the only difference being that in the second sessions no 

learning aids were provided.  This similarity led to a hypothesis stating that no change in 

perceived success would occur between the two sessions.  The behaviorist approach 

brings an additional level of individualism to the table, which likely placed a focus for the 

participants in Session 2 on recollection rather than skill building. 

Utilizing a t-test (t = 1.46, df = 16, p = 0.16), the results indicated a decrease in 

the Behaviorist group Learned Valuable Skills from Session 1 (Mean = 3.18) to Session 2 

(Mean = 2.94).  While the difference across the sessions was not significant, using 

Spearman rho, with a significance level of 0.05, a moderate correlation (r = 0.49) was 



	   62	  

found.  Participants who recorded a low level of learning during the first session recorded 

low levels during the second session; and those who indicated high levels of learning in 

the first session remained high.  The individualistic nature of the behaviorist 

methodology combined with the removal of the learning aid likely brought about a 

decrease in Learned Valuable Skills at the end of the second session.  With recollection 

and application using much of the participants’ effort, little effort was placed on skill 

building.  

 

H2.8: The Constructivist scores on the Learned Valuable Skills measure will increase 

from Session 1 to Session 2.  

In Session 1, students were not limited to individual work, and were able to 

control a great deal of the process by which they learned the information necessary to 

create the required end product.  This led to an assumption that participants may 

experience an increase in perceived success between the two sessions.  Additionally, the 

ability for students to work together and form a learning community might increase the 

chance of a student finding success in the learning session. 

A t-test was conducted (t = 1.72, df = 16, p = 0.10), and the results indicated a 

slight decrease in the Constructivist scores for Learned Valuable Skills from Session 1 

(Mean = 3.41) to Session 2 (Mean = 3.18).  While the difference was not statistically 

significant, Spearman rho was used to determine a very strong correlation (r = 0.77) with 

a significance level of 0.00.  Participants who reported a high level of learning after 

Session 1 reported a high level of learning after Session 2.  Conversely, those who 
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reported a low level of learning in Session 1 reported a low level of learning after Session 

2.  This slight decline in perceived success for the Constructivist participants could be 

due to a more valuable learning experience during Session 1.  In reality, if the learning 

experience in Session 1 was high in value, it is likely that repeating the product creation 

process in Session 2 would provide less new skill development.  If any participant felt he 

or she could not recall part of the information from the first session (regarding the 

software introduction), the experience would certainly decline. 

 

Table 6 

Comparisons of Group Scores in Perceived Difficulty 

 
Variables Behaviorist 

(Control) 
Constructivist 
(Experimental) 

Mean Score of Session 1 – Perceived Difficulty 1.76 1.35 

Mean Score of Session 2 – Perceived Difficulty 2.12 1.47 

Difference of Mean Score from Session 1 – Session 2 -0.36 -0.12 

Standard Deviation of Session 1 0.75 0.49 

Standard Deviation of Session 2 0.99 0.51 

Difference of Standard Deviation from Session 1 – 
Session 2 

-0.24 -0.02 

 

Note: N = 34 

*Perceived Difficulty was measured on a Likert scale of 1-5, 1 representing a low 

difficulty level and 5 representing a high difficulty level. 
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H2.9: For Session 1, the scores on the Perceived Difficulty measure for the Behaviorist 

group will be higher than the Constructivist group scores.  

While both the Behaviorist group and the Constructivist group were ultimately 

creating the same end product, the process by which the product was created differed.  

Without prior knowledge of the software taught in the learning sessions (for both groups), 

the Behaviorist group Perceived Difficulty was predicted to be higher simply because of 

the process by which they were introduced to the software (integrated within the product 

tutorial).  Additionally, in the behaviorist environment, individual assessment is typically 

the method used, and for that reason individual students are required to work only on 

their own projects.  The access that Constructivist participants had to talking and working 

with each other during their session was expected to lower difficulty levels for their 

group. 

Utilizing a t-test (t = 1.89, df = 32, p = 0.07), the results were as predicted by the 

hypothesis, but are not statistically significant.  The Behaviorist’s (Control group, Mean 

= 1.76, SD = 0.75) score of Perceived Difficulty for Session 1 was higher than the 

Constructivist’s (Experimental group, Mean = 1.35, SD = 0.49).  
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H2.10: For Session 2, the scores on the Perceived Difficulty measure for the 

Behaviorist group will be higher than the Constructivist group scores.  

Similar to the concept discussed in Hypothesis 2.9, the Perceived Difficulty level 

was predicted to be higher in the Behaviorist group after Session 2.  Both the Behaviorist 

and Constructivist groups were restricted to completing their projects without the 

learning aids in Session 2.  In Session 1, the Behaviorist groups followed a specific path 

in order to achieve the learning goal, and the removal of the learning aid in Session 2 was 

expected to be a greater hindrance than in the Constructivist group. 

In order to calculate results, a t-test was used (t = 2.39, df = 32, p = 0.02).  The 

mean scores for Perceived Difficulty between the Behaviorist group and Constructivist 

group, during Session 2, were as predicted by the hypothesis.  The Behaviorist group 

(Control group, Mean = 2.12) measured a higher score during Session 2 than the 

Constructivist group (Experimental group, Mean = 1.47).  Additionally, these findings 

were statistically significant (p = 0.05).  Without the learning aids, the Behaviorist group 

was left with fewer resources to utilize in the session.  The Constructivist group also was 

without the learning aid used in Session 1, but the learning environment might have 

contributed to higher levels of retention.  Additionally, the participants were still able to 

utilize the learning community, provide feedback, and ask questions among each other.  

This additional support system likely ensured the Perceived Difficulty level would be 

lower than that of the Behaviorist group. 
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H2.11: The Behaviorist scores on the Perceived Difficulty measure will increase from 

Session 1 to Session 2.  

Observing similar data as in Hypotheses 2.9 and 2.10, the Behaviorist group did 

not have access to the tutorial, and was restricted to individual recall in order to complete 

the second session.  Given the individualistic nature of the behaviorist methodology, 

students would only be able to rely on personal achievement and retention of knowledge 

from Session 1 to Session 2.  With the learning aid removed during the Session 2, it was 

assumed the difficulty level would increase. 

This hypothesis was examined using a t-test (t = -1.69, df = 16, p = 0.11), the 

mean scores of the Behaviorist group’s Perceived Difficulty, between Session 1 (Mean = 

1.76) and Session 2 (Mean = 2.12), were as predicted by the hypothesis but were not 

significant.  Using Spearman rho, a strong correlation (r = 0.54) was found, with a 

significance level of 0.03.  These results point out that scores which were high in Session 

1 remained high in Session 2, and recorded scores that were low in Session 1 remained 

low for Session 2.  The data show that while the Behaviorist participants responded 

similarly in Perceived Difficulty between Session 1 and Session 2, the removal of the 

learning aid combined with restricted interaction likely ensured a more difficult Session 2 

for the Behaviorist group. 
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H2.12: The Constructivist scores on the Perceived Difficulty measure will not change 

from Session 1 to Session 2.  

This hypothesis was derived from a prediction that the Constructivist participants 

would not experience a decrease in ability to problem solve and create as a result of the 

removal of the learning aid in Session 2.  The learning community formed by a 

constructivist method of teaching aids in information processing, research, feedback, and 

overall ability in achieving learning goals.   

A t-test was conducted (t = -0.81, df = 16, p = 0.43), and the mean scores of 

Perceived Difficulty slightly changed.  The score for Session 1 of the Constructivist group 

(Mean = 1.35) was lower than Session 2 (Mean = 1.47).  However, no statistical 

significance between these scores was determined (p = 0.05).  In review, the removal of 

the learning aid likely had a minor effect on the Perceived Difficulty level in Session 2 of 

the Constructivist group.  The constructivist environment, while allowing for more 

collaboration and a strategy for higher initial retention during Session 1, still required a 

certain amount of recollection that may or may not have affected the Perceived Difficulty 

level of the participants in Session 2. 
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Table 7 

Comparisons of Group Scores in Perceived Confidence 

 
Variables Behaviorist 

(Control) 
Constructivist 
(Experimental) 

Mean Score of Session 1 – Perceived Confidence 2.65 3.35 

Mean Score of Session 2 – Perceived Confidence 2.82 3.53 

Difference of Mean Score from Session 1 – Session 2 -0.17 -0.18 

Standard Deviation of Session 1 0.61 0.49 

Standard Deviation of Session 2 0.73 0.51 

Difference of Standard Deviation from Session 1 – 
Session 2 

-0.12 -0.02 

 

Note: N = 34 

*Perceived Confidence was measured on a Likert scale of 1-5, 1 representing a low 

confidence level and 5 representing a high confidence level. 

 

H2.13: For Session 1, the scores on the Perceived Confidence measure for the 

Behaviorist group will be lower than the Constructivist group scores.  

Students’ confidence in technology atmospheres have a great influence on the 

level of achievement and the utilization of skills to achieve learning goals (Neilsen et al., 

2010).  While both groups had little to no prior knowledge of the software being used 

during the session, the Constructivist group was given a short introduction on the use of 

the software as a standard environmental element of the constructivist approach.  
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Behaviorist participants were given only a tutorial that contained an integrated software 

tutorial and final product instructions.  This led to the hypothesis that the Constructivist 

group would feel more confident in their learning. 

Utilizing a t-test (t = -3.72, df = 32, p = 0.00), the Perceived Confidence scores for 

the Behaviorist group (Control group, Mean = 2.65) measured lower than the 

Constructivist group (Experimental group, Mean = 3.35) for Session 1.  These results 

were statistically significant (p = 0.05).  Data showed that the Constructivist participants 

felt considerably more confident in their learning than did those in the Behaviorist group.  

This is likely the result of more than one factor, including the software introduction that 

was given to the Constructivist group (which may have better framed the content to be 

learned), as well as the ability to work either individually or with other participants in the 

session. 

 

H2.14: For Session 2, the scores on the Perceived Confidence measure for the 

Behaviorist group will be lower than the Constructivist group scores.  

The same concept as Hypothesis 2.13 supports 2.14.  Honebein (1996) attributes 

intellectual development to be greatly supported and affected by the inclusion of social 

interactions as part of the learning process.  The constructivist approach supports 

teamwork and collaboration in acquiring new knowledge.  For this reason, a similar 

difference was predicted, where the Constructivist group would feel more confident 

during their second session than the Behaviorist group in their second session.     
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In order to calculate results, a t-test was used (t = -3.27, df = 32, p = 0.00).  The 

Behaviorist group’s scores for Perceived Confidence in Session 2 were lower than the 

Constructivist group’s scores at a statistically significant level.  The Behaviorist group 

(Control) scored a mean of 2.82, while the Constructivist group (Experimental) scored a 

mean of 3.53.  

The difference in confidence scores is slightly greater between the groups in 

Session 2 than in Session 1.  Without the tutorial (for the Behaviorist group) and the 

software introduction (for the Constructivist group), learner confidence was further apart 

as a result of the outcome of Session 2 relying completely on recalled information.  

Learner confidence for the Constructivist group was likely maintained due to the 

continued ability to work with others within the group had any participant wished. 

 

H2.15: The Behaviorist scores on the Perceived Confidence measure will decrease 

from Session 1 to Session 2.  

This hypothesis was generated from an assumption that the confidence of the 

Behaviorist group would be affected by the removal of the learning aid in Session 2.  

This group completed Session 1 following a step-by-step tutorial.  Essentially, illustrated 

instructions needed to complete the project were placed in front of the participant.  Each 

individual knew what was expected of them and most likely was satisfied when they 

reached the last page.  They may not have liked the actual design of the model, but they 

followed the task as it instructed them.  For the second session, each participant needed to 

rely on their memory of the project they completed two weeks earlier.  Without accessing 
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the tutorial, it was thought that the retention rate would be low enough to provide this 

decrease in confidence. 

A t-test was conducted (t = -0.77, df = 16, p = 0.46), and the results, while not 

significant,  indicated a slight reverse of the hypothesis, indicated by an increase in 

Perceived Confidence scores from Session 1 to Session 2 of the Behaviorist (Control) 

group.  The mean score of Session 1 was 2.65, while the mean score of Session 2 was 

2.82.  This reversal in outcome may be attributed to the retention rate being high enough 

to allow for modest learner confidence as found in Session 1.   

 

H2.16: The Constructivist scores on the Perceived Confidence measure will not 

change from Session 1 to Session 2.  

The constructivist approach promotes collaboration and peer interaction, both for 

information gathering as well as feedback on quality and process.  This hypothesis was 

generated as a result of the belief that confidence levels and ability to problem solve with 

other peers would make up for the loss of the learning aid from Session 1.    

Utilizing a t-test (t = 1.38, df = 16, p = 0.19), the results were slightly different 

than predicted by the hypothesis.  The Constructivist group’s scores of Perceived 

Confidence increased from the first to the second session.  The Experimental group 

scored a mean of 3.35 during Session 1, which was elevated slightly to 3.53 for Session 

2.  While not statistically significant, it is worth mentioning that although a learning aid 

was removed, the group as a whole showed an increase in confidence, which is a core 

attribute of the constructivist learning environment. 
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Table 8 

Comparisons of Group Scores in Design Embellishment 

 
Variables Behaviorist 

(Control) 
Constructivist 
(Experimental) 

Mean Score of Session 1 – Embellishment 1.12 1.65 

Mean Score of Session 2 – Embellishment 1.00 1.71 

Difference of Mean Score from Session 1 – Session 2 0.12 -0.06 

Standard Deviation of Session 1 0.33 0.49 

Standard Deviation of Session 2 0.00 0.47 

Difference of Standard Deviation from Session 1 – 
Session 2 

0.33 0.02 

Note: N = 34 

*Design Embellishment was measured on a scale of 1 or 2, with 1 representing that 

embellishments were not included in the final design and 2 representing that 

embellishments were included in the final design. 

 

H2.17: For Session 1, the scores on the Design Embellishment measure for the 

Behaviorist group will be lower than the Constructivist group scores 

This hypothesis was generated from the assumption that the general learning 

format of each Session 1 group would result in a behaviorist product that would be 

standardized (by the use of the step-by-step tutorial) and a constructivist product that 

would be largely varied in style and creativity level.  Savery and Duffy (1995) discuss the 

positive effects of a group learning experience, that these groups can have an “enriching, 
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interweaving, and expanding” effect on the learning environment.  The Constructivist 

group of learners, following constructivist core methodologies, had less of a restrictive 

process to follow, while opening the lines of communication between participants, 

bringing a wider array of opinions into a feedback cycle. 

In order to calculate results, a t-test was used (t = 3.67, df = 32, p = 0.00).  The 

results indicate support for the hypothesis at a significant level.  The mean score of 

Design Embellishment for the Behaviorist (Control) group during Session 1 was 1.12, 

while the mean score for the Constructivist (Experimental) group was 1.65. These results 

are statistically significant (p = 0.05).  Below are examples of models from both the 

Behaviorist group and the Constructivist group.  Both represent the top tier in accuracy 

for their respective group. The increase in Design Embellishment can be compared from 

the Behaviorist to the Constructivist group.  Both groups were given general 

requirements either through the tutorial (for the Behaviorist participants) or a guidelines 

list (for the Constructivist participants).  In this session, the Behaviorist example below 

illustrates a general adherence to the project specifications (including two exit doors, two 

windows, seating for 20, and a restroom).  The Constructivist example, however, shows a 

drawing that includes elements that go far beyond the requirements, such as a kitchen 

area, a bar, extra seating, and far more windows.   
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Figure 5. One of the better Behaviorist drawings from Session 1 
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Figure 6. One of the better Constructivist models from Session 1 
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H2.18: For Session 2, the scores on the Design Embellishment measure for the 

Behaviorist group will be lower than the Constructivist group scores. 

 Session 2 for both the Behaviorist and Constructivist groups included the removal 

of learning aids, which likely made the creation of the drawing more difficult.  The goal 

of the constructivist approach is one that allows for more creativity and critical thinking.  

It was expected that maintaining the individualistic nature of the behaviorist environment 

in Session 2 would produce a lower Design Embellishment and creativity level for the 

Behaviorist group. 

Utilizing a t-test (t = 1.34, df = 32, p = 0.19), the results indicate support of the 

hypothesis at a significant level.  The mean score on the Session 2 Design Embellishment 

measure for the Behaviorist (Control) group was 1.00, while the mean score for the 

Constructivist (Experimental) group was 1.71.  It has been concluded that the 

Constructivist group experienced less stress and was more accurate during Session 2 

when compared with the Behaviorist group, which is likely due to the removal of the 

tutorial from the Behaviorist group.  Neither group had tutorials or notes in the second 

session, only general guidelines for drafting their projects.  Since the Behaviorist group 

had learned the software and the process for building the drawing simultaneously, the 

amount of information recalled was most likely less than that of the Constructivist 

participants. A greater divide in the amount of Design Embellishment was noted in 

Session 2, as shown in the models below - one from the Behaviorist group and one from 

the Constructivist group.  In this session, both groups showed initiative to embellish, as 

can be seen in the examples below. While the Behaviorist example shows an adherence 

to the general guidelines, embellishments for the Constructivist group were even greater 



	   77	  

than the first session, which can be seen below with additions of a kitchen area, high 

cabinets, extra seating, and extra windows.  

 

 

Figure 7. One of the better Behaviorist drawings from Session 2  
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Figure 8. One of the Better Constructivist drawings from Session 2 
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CHAPTER V 

DISCUSSION AND CONCLUSIONS 

Overview 

This study analyzed many attributes of the learning environment within a 

classroom utilizing a behaviorist approach and a classroom utilizing a constructivist 

approach.  The overarching theme of this study is to add to research that explores the 

integration of traditional and progressive teaching methodologies in a way that ensures 

accuracy of content delivery, continues to support content retention, and in the case of the 

studio-based classroom, engages students in a learning experience that promotes critical 

thinking and creative achievement as part of the learning process.   

Behaviorist Approach 

As results were analyzed, it was clear that the behaviorist approach performed 

well in certain categories of assessment, the most important of these being the Evaluation 

Accuracy measure.  In the behaviorist methodology, accuracy in knowledge transfer is 

paramount to the success of the approach.   Shepard (2000) describes the behaviorist 

learning environment as one where small bits of knowledge are presented in a sequenced 

and hierarchical fashion, which supports comprehension from repetition.  In this study, 

the Behaviorist group participated in two learning sessions, and in both cases the 

Evaluation Accuracy measure was high.  This group was presented with a step-by-step 

tutorial in the first session to assess the effects of a standardized, sequenced approach to 

achieving learning goals.  Results of this session indicated a positive response technically 

to the behaviorist approach, with an average score of 4.00 on a five-point evaluation 

scale.  The second session, which was intended to gauge retention of knowledge learned 
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in Session 1 by removing the tutorial learning aid, scored slightly higher with the 

participants averaging 4.12 on the same five-point evaluation scale.  

In addition to the Evaluation Accuracy measure, the Behaviorist groups also 

scored well in the Learned Valuable Skills measure.  Participants completed a survey at 

the end of each session in which aspects of the learning environment and experience were 

rated using the Post-Session Survey.  While not as positive as the Evaluation Accuracy 

measure, the students showed a general agreement that valuable skills were learned 

during both sessions, averaging 3.06.   

The behaviorist approach appeared to suffer in other areas, including Completion 

Time and Total Stress, Perceived Confidence, and Design Embellishment.  The amount of 

time taken to complete each session was recorded for each participant.  The Behaviorist 

group in Session 1 recorded the highest completion time of all four sessions, with an 

average of 57 minutes and 24 seconds.  A positive note for this statistic is the greatly 

reduced completion time of the second session, where participants averaged only 35 

minutes and 24 seconds.  This 22-minute decrease, when coupled with the slight increase 

in Evaluation Accuracy, places a positive emphasis on the retention rate of students from 

the technical perspective in a behaviorist environment.   

Other measures analyzed as part of the second research question (Does the 

instructor’s choice of a constructivist approach versus behavioral impact students’ 

behavior during and attitude towards studio-based learning?) were less positive.  Total 

Stress, measured as indicators of learning stress recorded by trained observers during the 

learning sessions, was high at 12.76 during the first Behaviorist session(which means that 
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on average, a Behaviorist participant exhibited almost 13 visual signs of learning stress 

during the first session).  More impressive is the increase in this measure when compared 

with the Session 2 score of 18.29.  This increase of 5.53, or 43.3%, from Session 1 to 

Session 2 is an indication that while accuracy increased, the cost of accuracy was 

increased learning stress.   

Perceived Confidence was measured to determine how comfortable the 

participants felt during each of their sessions.  The Behaviorist sessions were similar to 

one another in this measure, scoring a mediocre 2.65 and 2.82 (out of a possible 4.0) in 

Session 1 and Session 2 respectively.  These results suggest that students felt only 

marginally confident in their learning achievement during each Behaviorist session.  An 

interesting concept specifically relating to confidence is that even though the students 

were provided a step-by-step tutorial in Session 1 that was essentially a written 

walkthrough of the product to be designed, students did not express confidence in 

completing the session with accuracy.   

Design Embellishment was a measure intended to determine the tendency for 

students to work beyond specified requirements as a result of the learning environment.  

In both sessions, few participants used any remaining time allotted for the session to add 

personal embellishments or creative elements to their drawings.  This lack of creativity 

was expected for Session 1 where the tutorial was used, simply because once the 

participants reached the end of the tutorial, they would feel the project was complete.  

Additionally, without incentive to do additional work beyond the scope of the tutorial, 

participants were unlikely to elaborate on their drawings.  The second session for the 

Behaviorist group contained aspects of constructivism, mainly in the learning goal phase 
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of the session.  Only general requirements were given for the end product to be created, 

which gave the students more opportunity to participate in the learning process by 

allowing freedom in determining the process by which they would design their drawings.  

Even with this inclusion of some freedom into the behaviorist construct, students showed 

a decrease in the amount of design embellishments and creative additions to drawings.     

Constructivist Approach 

The Constructivist group revealed high marks in most of the categories assessed, 

both in accuracy as well as behavior.  Evaluation Accuracy, in particular, was extremely 

high in the Constructivist group, with participants in Session 1 averaging a 4.71 out of a 

five-point evaluation scale.  While slightly lower, participants from Session 2 scored 4.59 

out of a possible 5.  The level of success was not expected in this category, particularly in 

Session 1 where the corresponding Behaviorist group was using a learning aid that 

walked participants through the development process.  The Constructivist group was 

given a software introduction in lieu of the step-by-step tutorial, which supports a 

positive assessment of the constructivist environment as it pertains to accuracy in 

achievement.   

Completion times for Sessions 1 and 2 for the Constructivist group were similar if 

the software introduction is factored into the analysis.  While the average completion 

time for Session 1 was 49 minutes and 53 seconds, the actual working time for the 

participants was about 15 minutes less (the software introduction was 15 minutes long).   
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From the perspective of behavior, attitude, and creativity, the Constructivist 

groups submitted the same post-session survey and were observed in the same manner as 

the participants in the Behaviorist group.   

The Learned Valuable Skills measure was comparable with the Behaviorist group 

in both sessions, indicating only a slightly higher response to whether or not skills 

learned during the sessions were valued.   

Higher Perceived Confidence scores within both Constructivist groups were 

statistically significant as compared with the Behaviorist group.  Sessions 1 and 2 of the 

Constructivist group scored 3.35 and 3.53 respectively, compared to 2.65 and 2.82 for the 

Behaviorist sessions.   

The Perceived Confidence measure likely influences the amount of stress 

experienced by learners involved in the sessions.  The trained observers recorded a 

significantly reduced number of stress indicators (found in Table 4, Chapter 4) when 

observing the Constructivist sessions (as compared to the Behaviorist sessions).  Session 

1 of the Constructivist group revealed a score of 9.76.  More revealing is the score of 6.29 

recorded in Session 2, which was less than 35% of the stress indicators recorded in 

Session 2 of the Behaviorist group.  This is an important group of statistics when 

combined with Evaluation Accuracy, showing that participants in the Constructivist 

group were more accurate in achieving their learning goal and showed fewer signs of 

learning stress during the session, particularly in Session 2 of both groups.   

Design Embellishment is an aspect of creative assessment essential to the study in 

comparing methodologies.  Scores recorded in the Constructivist group were much higher 
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than those participating in the Behaviorist sessions.  While fewer than 25% of Behaviorist 

participants included design embellishments in their projects, over 50% of Constructivist 

participants went beyond the general requirements of the sessions.  The level of observed 

embellishment was greater within the Constructivist group, as shown in the images at the 

end of chapter 4.  The sample of images shown was indicative of the entire group’s 

creative performance.   

Integration of Methodologies 

Both the behaviorist approach and the constructivist approach exhibited positive 

outcomes as well as negative.  Both methodologies contributed to high accuracy scores, 

value in skill development, decreases in goal achievement time in the second sessions, 

and a degree of creative output.   

The importance of utilizing aspects of both approaches as an integrated or hybrid 

methodology has strong implications as post-secondary studio-based education continues 

to evolve.  The behaviorist methodology has historically been utilized to ensure accuracy 

in achievement, and this has been true throughout this study.  Studio-based curricula 

continue to evolve in a way that requires a more global development of skills, including 

skills that go far beyond technical achievement.   

Cognitive load theory is an essential element in designing instructional content at 

the course level as well as the lesson level.  Chandler and Sweller (1991) explain that a 

poorly designed learning activity can drive learners to thinking and processing of 

information that is largely irrelevant, or at best inefficient, to presented learning goals.  

Learning stress, confidence, and lack of creative production have all been attributed to 
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some degree to unmanaged cognitive load, particularly within inexperienced students or 

those that have little prior knowledge in a subject.  By managing cognitive load and 

providing learning experiences that are designed to reduce learning stress, increase 

confidence, and promote creativity, the studio-based classroom can evolve in a way that 

better prepares students for transition into the professional world.   

Creativity is often discussed as a sought skill, but execution of curriculum in the 

form of studio classes has frequently lacked the attributes within the learning 

environment that encourage such exploration.  The value placed on college graduates that 

exhibit skill and ability to think and design creatively is great, but employers have 

consistently labeled creativity as an attribute most lacking in entry-level applicants (Reid 

and Petocz, 2004).  Creativity is a difficult skill for faculty members to assess, let alone 

teach.  The Design Embellishment measure performed in this study resulted in a strong 

relationship between unsolicited development of creative elements and the constructivist 

learning environment.  Students in the Constructivist sessions were more than twice as 

likely to explore the assignment beyond the provided requirements, as verified by the 

increased scores in the Design Embellishment measure.  This is an important statistic to 

note, since both the creativity level and accuracy were higher in the Constructivist group 

than in the Behaviorist.  A higher accuracy score plus a lower Total Stress score leads to 

the assumption that the learning session was easier to complete for the Constructivist 

participants.  Combine this with the shorter completion times, and it seems likely that a 

less stressful, less restrictive leaning environment can lead to higher creative output. 

 An important factor in the decision to perform this study was the researcher’s 

faculty position at Indiana University of Pennsylvania.  The difficulty in managing 
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diminishing face-to-face time with students with an increase in industry requirements for 

recent graduates has been a point of frustration.  Pressure from the Interior Design 

industry for gaining program accreditation is a monumental process that is becoming 

more important for recruitment of new students and retention of current students.  The 

Council for Interior Design Accreditation (CIDA) presents rigorous requirements and 

rubrics for assessing learning environments and academic standards in their Professional 

Standards 2011 document.  Beyond the core components of the technical skills 

curriculum, CIDA requires that a university curriculum demonstrates the ability to 

engage students in a learning environment that supports and promotes (CIDA, II-7): 

1. Global Perspective for Design 

2. Human Behavior 

3. Design Process 

4. Collaboration 

5. Communication 

6. Professionalism and Business Practice 

 These are elements of a learning environment that traditional behaviorist practices 

generally have not fostered.  Fifteen years ago, it was sufficient for many Interior Design 

programs to teach an emerging technology called Computer-Aided Drafting (CADD) as a 

singular course.  The evolution of technology has provided many additional software 

packages that can be used in conjunction to develop plans, drawings, and 

recommendations to clients.  In addition to CAD design, software is available for 

Building Information Modeling (BIM), and even experience with aesthetic and layout 

programs such as Adobe’s Illustrator and InDesign are skills valued by employers in the 
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industry.  All of these new technologies go beyond the technical aspect of the software 

and so must be addressed to a certain degree to prepare a student for the work force.  

Creativity and critical thinking must be promoted to utilize the right tools for the right 

purposes and to foster higher-level decision-making.  This study, providing much-needed 

rigorous support, was aimed at identifying aspects of sound practice that can foster 

collaboration, critical thinking, and creativity while improving retention rates between 

classes as well as academic semesters. 

Recommendations 

One way to integrate the behaviorist methodology is to provide tools and 

encourage research.  This study has shown that both the behaviorist and the constructivist 

methodologies have the potential to deliver accuracy in learning goals, but the behaviorist 

approach is limited in its capacity to broaden students’ knowledge within the learning 

environment.  Pre-developed tools and supports (such as the tutorial used in this study) 

can be valuable as long as they do not define the entirety of the learning experience.  As 

seen in the first Behaviorist session, while accuracy was high in the end product, learning 

stress was elevated and student confidence was low.  If supports are provided, students 

should be encouraged to use them as a foundation and broaden their knowledge using any 

number of regulated information sources, from access to online resources to engaging in 

discussions with peers that may have a deeper knowledge in content areas.  It was 

revealed through elements of this study that when students have opportunities to 

collaborate with one another, even if the end result is assessed individually, the learning 

process can be less stressful, elicit more creativity, and take less time.  This combination 

of the behaviorist and constructivist imperative to developing lesson plans and new studio 
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courses that need to teach more content than is traditionally taught in the same amount or 

less time.  

While it is imperative to maintain rigorous accuracy standards, creativity 

shouldn’t be lost in the process.  Participants in the Behaviorist group, when provided 

with the all-encompassing tutorial, were satisfied to submit a standard drawing.  While 

accuracy levels were high and creativity and embellishment were not requirements of the 

session, the inherent nature of the lesson structure did not encourage creative exploration.  

The Constructivist participants provided a wide array of drawings that exhibited many 

levels of creativity without sacrificing accuracy (see Design Embellishment, Figure 7 on 

page 72).  This study has shown that students that are more involved in the learning 

process are more likely to feel ownership of their own learning and take initiative to 

shape the learning experience in a way that is beneficial to individual learning styles.  

This is evident in the increase in design embellishment and the tendency to go beyond 

requirements exhibited by the Constructivist group, particularly in Session 2. 

If the content delivered in this experiment was to be used in a transitional 

classroom experience with a combination of methodologies, it might begin by providing 

a written support tool that teaches the software, which would then be supported by an 

introductory lecture and discussion.  In order to manage cognitive load, this first 

“session” would focus only on the use of the software.  A second session (or classroom 

period) would then provide an introduction of a project, perhaps like the one used in this 

experiment, where students can use the information learned in the first session to work 

towards a broader, more creative product.  This second session would follow the 

constructivist methodology, allowing students to work together and to research beyond 
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the standard written books and tools to enrich the learning experience and provide deeper 

interactions within a learning community.  This approach, teaching software in a 

behaviorist-centered environment and the application of this knowledge in a broad, 

constructivist atmosphere, could greatly impact the learning outcomes of the students. 

Areas for Future Research 

 This study has explored the effects of two teaching methodologies on a studio-

based curriculum.  After analyzing the learning sessions, some areas for improvement 

arose.  If this study were performed again, a few changes would be proposed.  First, a 

larger and more diverse (with age) sample would be used.  This would allow for a 

stronger argument for effects on accuracy, with a group exhibiting a more varied 

background in regards to knowledge of software and experience in Interior Design.  Also, 

as part of the Post-Session Survey, students would be asked the following question in 

addition to those already included in the survey: “Would you have liked more time at the 

beginning of the session to explore the software tools before beginning the project?”  

Perhaps more individual exploration time would have allowed accuracy scores between 

the sessions to increase.   

While the data provided an enlightening view of how students perform within 

each of the methodologies, the scope of the experiment was fairly narrow, limiting the 

study to mostly Junior/Senior-level Interior Design students.  This experiment will 

benefit not only Interior Design studio courses, but also other studio courses in other 

curriculum areas.  For example, the goals of this study would be well-suited to be tested 

within Fine Arts and Communications Media.  Fine Arts, specifically Graphic Design, is 
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software-rich, with many avenues and options available to achieve different artistic goals.  

The Adobe Creative Suite alone contains 17 programs and extensions.  The learning 

curve for younger Fine Arts students potentially could be greatly reduced with studies 

like this one applied to current classes.  Further, Communications Media adds a studio 

core that includes many production and audio products, where software is the center of 

many classes.  Both Fine Arts and Communications Media place value in creativity, 

which could be a focus of growth in future years.  Results of this study could be valuable 

in targeting limited resources toward future growth. 

As curricula grow across all academic areas, the need for further research into the 

conversion of current traditional course content into online and e-learning platforms will 

continue to be an area of expansion.  This study could be the basis for a more generalized 

assessment of retention and creativity between traditional (face-to-face) and online (or 

electronic) learning environments.  The need for institutions to continue demonstrating 

flexibility and adaptability will continue to grow.  

While the behaviorist method of instruction is deeply rooted in many academic 

settings and certainly has merit in many situations, it is recommended that studio faculty 

begin (or continue) to include aspects of the constructivist model into the learning 

environment.  Only through dedicated emphasis on the teaching behaviors that promote 

creativity, critical thinking, and ownership of the learning process will students be 

appropriately prepared for their design careers.     
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Appendix A – In-Class Announcement           

 

 “As a part of the research for my dissertation, I am conducting a teaching study. 

Volunteers will be separated into two groups who will meet twice for about 2 

hours each session and will be provided dinner. You all will be drafting the same 

model in Revit, but each group will learn to use Revit in a different manner. There 

are five sets of dates available, so if you are interested, you will be able to request 

certain days to participate that will be convenient for you. The models you draw 

and the data will be anonymous, so you don’t have to worry about your names 

being attached to any published information.” 

 

[Sign-up sheets were distributed to all students] 

 

“If you are not interested in participating, simply hand your blank form back to 

me.  If you aren’t sure and have questions, please email me or talk to me in person 

– I’ll be happy to answer any questions.” 
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Appendix B - Informed Consent Form 

 
Title of Study: Impact of Learning Theory Methods on Undergraduate’s Retention and Application of Software in 
a Studio Setting 

Principal investigator: Julie L. Gomboc-Turyan, M.A.  

  You have been invited to participate in a research study that will compare two different methods of 
teaching the same material.  Two groups will be formed from the pool of students volunteering for this study.  Each 
group will meet for two separate learning sessions, and dinner will be provided to all students after every session. 

You will first complete a short demographic survey containing information about your age, GPA, prior 
experience with software, and academic history.  Once you arrive to the learning site for the first session, the first step 
will be to draw an electronic model using Autodesk Revit.  You will have help completing this drawing in the form of 
either a step-by-step tutorial or a beginning demonstration of the software, depending on the group you have been 
assigned to.  After you have drawn the model, I will give you a short survey to complete where you will tell me about 
your learning experience.  This first meeting will last no more than two hours. 

Two weeks later, you will return and draw the same model that you completed in the first meeting, only 
this time you will not be given the step-by-step tutorial or the beginning demonstration. After you have drawn the 
second model, I will give you a short survey to complete where you will tell me about your learning experience.  The 
second meeting will last no more than two hours. 

  In conducting this research I am very careful to safeguard your personal information. As soon as you 
volunteer, a number is assigned to your name, and the original demographic survey is destroyed.  Your name is only 
kept on record in a single electronic file until the learning sessions are complete, and then will be removed 
completely from the study, even before the post-session survey results are reviewed.  Your participation in this study 
is voluntary. You can withdraw your consent and discontinue your participation in the project at any time by calling 
or emailing me (the principal investigator) using the contact information below. If you wish to discontinue 
participation during one of the sessions, you can do so by simply telling the principal investigator in person, and you 
will be free to leave at your discretion.  If you have any questions or concerns, contact either myself or my faculty 
sponsor: 

 

Principal Investigator: 
 
Julie L. Gomboc-Turyan, M.A. 

Instructor, Interior Design 
Doctoral Candidate, Communications 
Media & Instructional Technology 
Indiana University of Pennsylvania 
205A Ackerman Hall 
Indiana, PA 15705-1087 
724-357-4414 
turyan@iup.edu 

Faculty Sponsor/Committee Chair: 
 
Dr. Mark Piwinsky 

Chairperson, Department of Communications Media 
Indiana University of Pennsylvania 
121 Stouffer Hall 
Indiana, PA 15705-1087 
724-357-3954 
Mark.Piwinsky@iup.edu 

THIS PROJECT HAS BEEN APPROVED BY THE INDIANA UNIVERSITY OF PENNSYLVANIA 
INSTITUTIONAL REVIEW BOARD FOR THE PROTECTION OF HUMAN SUBJECTS.  

PHONE (724) 357-7730  
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Appendix C – Volunteer Sign-Up Sheet 

 
 

Name  

Imail Address  

Preferred Dates 

(Check all that you are 
available for) 

Sunday, April 15 & Sunday, April 29 from 5-7pm 

Tuesday, April 17 & Tuesday, May 1 from 5-7pm 

Thursday, April 19 & Thursday, May 3 from 6-8pm 

Friday, April 20 & Friday, May 4 from 5-7pm 

Saturday, April 21 & Saturday, May 5 from 4-6pm 
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Appendix D – Voluntary Consent Form 

 

I have read and understand the information on the Informed Consent form and I consent to 
volunteer to be a subject in this study. I understand that my personal information is completely 
confidential and that I have the right to withdraw at any time. I have received a copy of the 
Informed Consent form to keep in my possession. I understand and agree to the conditions of this 
study as described. 
 

Name:  (PLEASE PRINT) _________________________________________________ 

 

Signature ________________________________________________________________ 

 

Date ____________________________________________________________________ 

 

Phone Number ______________________________ 

 

Email Address _____________________________________________________ 

 

I certify that I have explained to the above individual the nature and purpose, the potential 
benefits, and possible risks associated with participating in this research study, have answered any 
questions that have been raised, and have witnessed the above signature. 

 

 

_______________                                _________________________________________ 

Date                                                       Investigator’s Signature 

 

 

THIS PROJECT HAS BEEN APPROVED BY THE INDIANA UNIVERSITY OF PENNSYLVANIA 
INSTITUTIONAL REVIEW BOARD FOR THE PROTECTION OF HUMAN SUBJECTS.  

PHONE (724) 357-7730 
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Appendix E – Pre-Session Demographic Survey 
 

1. What is your age?  _____________ 
 

2. What is your gender?  Please circle one.             Male          Female 
 

3. What is your current GPA?  Please circle one. 

a. 0.0 – 0.49 
b. 0.5 – 0.99 
c. 1.0-1.49 
d. 1.5 - 1.99 
e. 2.0 – 2.49 
f. 2.5 – 2.99 
g. 3.0 – 3.49 
h. 3.5 – 4.0 
i. I don’t know 

 
4. What year of school are you currently in? 

a. Freshman – Year One 
b. Sophomore – Year Two 
c. Junior – Year Three 
d. Senior – Year Four 

 
5. How many INDS have you taken prior to this study?   

Please check all that you have completed and are currently enrolled in: 

INDS 105 – Intro to Interior Design 

INDS 118 – Drafting for Construction I 

INDS 205 – Color Theory and Application 

INDS 218 – Drafting for Construction II 

INDS 230 – Presentation for Interior Design 

INDS 240 – 3-D Design for Interior Design 

INDS 305 – Interior Lighting 

INDS 310 – Human Factors in Interior Design 

INDS 313 – Materials & Finishes 

INDS 315 – Residential Design I 

INDS 319 – Residential Design II: Kitchen & Bath 

INDS 370 – Development of Design I 
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INDS 380 – Development of Design II 

INDS 405 – Professional Practice 

INDS 464 – Contract Design I 

INDS 465 – Contract Design II 

 

6. Please describe your academic history by circling the letter of one of the following 

options that best describes you. 

a. I have been an Interior Design major since I began taking classes at IUP. 

b. I changed my major to Interior Design from another major at IUP. 

c. I transferred to IUP from another school where I was an Interior Design major. 

d. I transferred to IUP from another school where I was not an Interior Design major. 

e. Other (please describe) 

_____________________________________________________________ 

 

7. Please describe your comfort level with technology using the following scale. Place a 

checkmark in the corresponding circle or circle the appropriate description.

 
  

I	  am	  not	  at	  all	  
comfortable	  

using	  
technology,	  
and	  have	  no	  
experience	  

I	  don't	  often	  
use	  

technology,	  
and	  do	  not	  

feel	  
comfortable	  
when	  I	  do	  

I	  don't	  often	  
use	  

technology,	  
but	  feel	  

comfortable	  
when	  I	  do	  

I	  use	  
technology	  
often,	  but	  
don't	  always	  

feel	  
comfortable	  

I	  use	  
technology	  
often,	  and	  
feel	  very	  

comfortable	  
using	  it	  

I	  consider	  
myself	  an	  
expert	  when	  
technology	  is	  
concerned	  
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8. How many courses have you taken that involved learning new software as part of the 

curriculum? 

a. 0 – 2 
b. 3 – 5 
c. 6 – 10 
d. 11 or more 
e. I’m not sure. 

 

9. How many courses have you completed that involved a studio-based classroom 

environment (including ART, COMM, THTR courses)? 

a. 0 – 2 
b. 3 – 5 
c. 6 – 10 
d. 11 or more 
e. I’m not sure. 
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 Appendix F – Step-by-Step Tutorial           
 

Autodesk Revit Architecture – Beginner’s Tutorial 

Creating a Basic Layout for a Coffee Shop or Cafe 

 

Create A New Project 

 

1. Open AutoDesk Revit Architecture from the program menu on your computer.   
 

 

Introduction to the User Interface 
 

Below is a picture of the standard Revit Architecture user interface.  Refer to this image when you need to 
review the areas of the workspace. 

 

Tab BarRevit Home Button

Work Area

Component 

Properties 

Area

Project 

Browser 

Area

Ribbon
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Note**: Throughout this project you will need to zoom in and out of your drawing.  Since everyone 
will want to use this tool in a different way, simply use the scrolling wheel on your mouse when you 
wish to zoom in or out.  Scrolling the wheel north will zoom into your drawing area, and scrolling 
south will zoom out of your drawing area. 

 

Create A New Project 

 

1. To create a new project, click on the Revit Home button at the top left of the toolbar, hover over 
the New button, and click Project on the extended menu.  
 

 
 

2. In the New Project dialog box that appears, ensure that the default template is selected, and that 
the radio button beside “Project” is also selected.   

 

3. Click OK.   
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Save Your Project 

 

1. Save your new project immediately by clicking on the Revit Home button at the top left of the 
toolbar, hovering over Save As, and then clicking on Project. 

 

2. In the Save As dialog box that appears, select Desktop as your destination, select your 
corresponding project folder, and name your project in the following fashion: StudentID_Session#. 
 
So, if your student ID is Crimson05, and you are in the first of two sessions, you would name your 
project Crimson05_Session1.   

 

3. Click OK. 
 

 

Using the View Cube in 3D Mode 
Throughout the project, you can utilize the View Cube for 3D viewing of your model.  This is not a required 
step of the tutorial, but can be valuable in reviewing the placement of objects and the progress of your 
drawing. 
 

1. To view your project in 3D Mode, click the View Tab, and then click the Default 3D View 
button.  
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2. Your model will change to show a 3D view.  The View Cube will appear at the top right of the 
screen, and you can click the corners, sides, top and bottom, and directional elements (North, 
South, East, West) to change the angle at which you are viewing the model.  You can also grab the 
View Cube with your mouse pointer and turn or pivot the model in any direction.  See below for 
examples of the View Cube selection areas.  
 
 

 
 

3. Click on the Floor Plan: Level 1 link in the Project Browser to return to standard Floor Plan 
editing mode. 
 
 

 

Draw the Exterior Walls 

Draw the exterior walls by following these steps: 

  

1. Select the Home tab. 
 

2. Click the arrow under the Wall button on the Ribbon (this will populate a drop-down menu). 
 

3. Select Structural Wall from the drop-down menu. 
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4. In the properties box, change the wall type to Exterior – Brick and CMU on MTL. Stud. 
 

5. With the intent to draw the walls in a clockwise motion, click the cross-haired cursor in the lower 
right quadrant of the screen (see example below). 
 

6. After you have clicked, a temporary wall will extend from your cursor and move wherever you 
move the mouse.   From the spot where you clicked, move the mouse to the left, ensuring the wall 
is straight.   
 

7. While the wall is still attached to your crosshairs, type 45’ (the length entry field will 
automatically appear). 
 

8. Click Enter. 
 

9. From this point, move your cross-haired cursor north to begin a straight wall perpendicular to the 
last wall you created.  In the same manner as in the last step, type 35’. 
 

10. Click Enter. 
 

11. Drag your cross-haired cursor to the right until it reaches the original point of the first wall and a 
blue line appears connecting the current wall and the original. 
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12. Click the mouse once to set the ending point for the third wall. 
 

13. Drag your cross-haired cursor south until it touches the original wall and a purple box appears.  
Click the mouse one last time to connect the fourth wall to the first. 
 

14. Click the Esc button on your keyboard twice (clicking it once will remove the drawing command 
from your crosshairs, however you will still be in drawing mode.  Clicking a second time will 
remove you from drawing mode altogether). 
 
  

Centering the Drawing 
 

1. Drag room to middle of the work area by clicking and holding your mouse outside of the top left 
of your exterior walls and dragging to the right and down over the entire building.  Release the 
mouse button and click one of the walls.  Holding the mouse button, drag the building so that it is 
relatively centered between the elevation markers.  (See example below - it does not have to be 
perfectly centered). 
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Change the Height of the Exterior Walls 

 

1. In the project browser, double-click the EAST elevation found beneath the Elevations heading 
(this will change your work area from the top view of the layout to a view of the building as it 
would be seen from the east side of the site). 
 

2. Drag the cursor to either of the top right side or bottom of the wall and click once, selecting the 
eastern-facing wall (see below). 
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3. Under the properties area for the wall (on the left-hand side of the page, above the project browser 
window, you will find a property item labeled Top Constraint.  Click in the area to the right of 
this property, and when the drop-down menu appears, select Up to level: Level 2. 
 

4. Repeat steps 1-3 of this section for the remaining three elevation views – North, South, and West. 
 

5. When all four walls have been adjusted for height, double-click on Floor Plan Level 1 in the 
Project Browser. 
 

 

Draw Interior Walls – Bathroom 
 

1. On the top left of the ribbon, in the Home tab, click the Wall button. 
 

2. Under properties, change the selection to Generic 4” Brick. 
 

3. With the crosshairs activated, move your cursor to the lower side of the right-hand wall, as seen 
below.  Click your mouse once to attach the interior wall to the exterior. 
 
 

 
 
 
 

4. Drag your cursor to left in a straight line and type 10’. 
 

5. Drag cursor down until it meets the bottom wall and click the mouse.  Your walls should be 
attached on both sides to the exterior of the building. 
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6. Hit the Esc key twice, as you did after you had finished drawing the exterior walls.   
 

7. To insure that the bathroom is square, click on the north wall of the bathroom.  You will see a 
measurement field appear on the left-hand wall, which designates the length of the wall.  If it is 
not 10’ in length, click in the measurement field and type 10’ and hit the Enter key. 
 

8. Double-check you work by clicking on the left-hand wall of the bathroom and insuring the width 
is also 10’.  If it is not, repeat step 7 with the adjoining wall. 
 

9. As you did for the exterior walls, you need to change the Top Constraint of the interior walls.  
Click one of the bathroom walls. 
 

10. Under the properties area for the wall (on the left-hand side of the page, above the project browser 
window, you will find a property item labeled Top Constraint.  Click in the area to the right of 
this property, and when the drop-down menu appears, select Up to level: Level 2. 
 

11. Repeat steps 9 and 10 for the second bathroom wall. 
 

 

Creating the Bathroom Door 
 

1. Click the Home tab. 
 

2. Click the Door button. 
 

3. Under the properties tab for the door, select the correct door type by clicking the type drop-
down menu and selecting Single-Flush 36” x 84”. 
 

4. Move cursor so that the centerline of the door is 7’- 6” from the north wall of the bathroom.  
Ensure the door is opening to the inside of the bathroom.  
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5. Click your mouse once.  
 

6. Hit the Esc key. 
 
 

Inserting a Commode Fixture 
 

1. Click the Insert tab. 
 

2. Click on Load Family on the ribbon. 
 

3. In the dialog box that appears, double-click the Plumbing Fixtures folder. 
 

4. Select Toilet-Commercial-Wall-3D. 
 

5. Click Open. 
 

6. Click the Home tab.   
 

7. Click on the Component Button. 
 

8. In the Properties area, click the type drop-down and select the commode you have 
downloaded with a height of 19”. 
 

9. Place your cursor on the left (East) wall of bathroom until the centerline is 2’ from the north 
wall of the bathroom. 
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10. Click once to place the commode. 
 

11. Hit the Esc key. 
 

 

Inserting a Sink Fixture 
 

1. Click the Insert tab. 
 

2. Click on Load Family on the ribbon. 
 

3. In the dialog box that appears, double-click the Plumbing Fixtures folder. 
 

4. Select Vanity - Square. 
 

5. Click Open. 
 

6. Click the Home tab.   
 

7. Click on the Component Button. 
 

8. In the Properties area, click the type drop-down and select the sink you downloaded. 
 

9. Place your cursor on the right (East) wall of bathroom until the centerline is 6’ from the north 
wall of the bathroom. 
 

10. Click once to place the sink. 
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11. Hit the Esc key twice. 
 

12. You will notice the sink is not facing the proper direction.  You need to rotate the component.  
Click on the Modify button in the Ribbon so that you have a standard cursor.  Click once on 
the sink. 
 

13. In the Ribbon, click the Rotate Tool (see below). 
 

 
 

14. Place your cursor above the sink until a vertical line appears (see below).  
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15. Click the mouse button and drag your mouse in a clockwise circle to change the angle of the 
sink. 
 

 
 

16. With the angle at 90 degrees, click again.   
 

17. Hit the Esc key twice. 
 

18. Select the sink, and move it so that it is flush with the back wall of the bathroom.   
 
 

Creating the Main Entrance 
 

1. Click the Insert tab. 
 

2. Click on Load Family on the ribbon. 
 

3. In the dialog box that appears, double-click the Doors folder. 
 

4. Select the door labeled Double-Glass 1. 
 

5. Click Open. 
 

6. Click on the Door Button in the ribbon. 
 

7. In the Properties area, click the type drop-down and select the door that you downloaded.  
Specifically, select the 72” x 84” version of the double door. 
 

8. Place your cursor on the left (West) wall. A temporary sketch of the door should appear. 
 

9. Position the cursor on the outside of the wall and in a position that has an even distance above 
and below the door’s centerline, as well as showing the doors opening outward.  In this case, 
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you should see an even distance of 17’- 6” on both sides of the door. 
 

 
 

10. When you have reached this point, and the door is in alignment, click your mouse to place the 
door.   
 

11. Hit the Esc key twice. 
 

 
Creating the Emergency Exit Door 
 

1. Click the Home tab. 
 

2. Click the Door button. 
 

3. Under the properties tab for the door, select the correct door type by clicking the type drop-
down menu and selecting Single-Flush 36” x 84”. 
 

4. Move cursor to the back wall of the building, so that the centerline of the door is 17’- 6” from 
the north wall of the bathroom.  Ensure the door is opening to the outside of the building.   
 

5. Click once to place the door. 
 

6. Hit the Esc key twice. 
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7. At this point, your drawing should closely resemble the one below. 
 

 
 

 

Creating the Front Exterior Windows 
 

1. Click the Insert tab. 
 

2. Click on Load Family on the ribbon. 
 

3. In the dialog box that appears, double-click the Windows folder. 
 

4. Select the window labeled Archtop with Trim. 
 

5. Click Open. 
 

6. Click on the Window button in the ribbon. 
 

7. In the Properties area, click the type drop-down and select the window that you downloaded.  
Specifically, select the 72” x 48” version of the Archtop with Trim window. 
 

8. Position your cursor on the front wall of the building so that it is between the main entrance 
door and the north wall of building. 
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9. When you have the window positioned 7’ - 6” from the top of the building, click once to place 
the window.  DO NOT HIT THE ESC KEY. 
 

10. With the Window tool still selected, place a second window 7’ - 6” from the south wall of the 
building.   
 

11. Hit the Esc key twice. 
 

 

Placing Tables  
 

1. Click the Insert tab. 
 

2. Click on Load Family on the ribbon. 
 

3. In the dialog box that appears, double-click the Furniture folder. 
 

4. Select Table-Dining Round w Chairs. 
 

5. Click Open. 
 

6. Click the Home tab.   
 

7. Click on the Component Button. 
 

8. In the Properties area, click the type drop-down and select the table you downloaded – you 
will have three size options – choose 60”. 
 

9. Place your cursor in the upper left area of the open space within the building, and place three 
tables.  You can simply click once, move your mouse, and click again.  After you have placed 
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the tables, hit the Esc key twice.   
 

10. Click the Modify button in the Ribbon, and move the tables around to resemble the image 
below. 
 

 
 

 

Placing the Sofa 
 

1. Click the Insert tab. 
 

2. Click on Load Family on the ribbon. 
 

3. In the dialog box that appears, double-click the Furniture folder. 
 

4. Select Sofa-Pensi. 
 

5. Click Open. 
 

6. Click the Home tab.   
 

7. Click on the Component Button. 
 

8. In the Properties area, click the type drop-down and select the sofa you downloaded – you 
will have two size options – choose 84”. 
 

9. Place your cursor in the upper right area of the open space within the building, and place a 
sofa by clicking once (see below). 
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10. Click Esc twice.   
 

11. You will need to rotate the sofa 90 degrees much like you did with the vanity sink in the 
bathroom.   
 

12. Place your cursor above the sofa until a vertical line appears.  
 

13. Click the mouse button and drag your mouse in a clockwise circle to change the angle of the 
sofa. 
 

14. With the angle at 90 degrees, click again.   
 

15. Hit the Esc key twice. 
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16. Select the sofa, and move it so that it is close to the east wall (see image below).   
 

 
 

 
Placing the Coffee Table 
 

1. Click the Insert tab. 
 

2. Click on Load Family on the ribbon. 
 

3. In the dialog box that appears, double-click the Furniture folder. 
 

4. Select Table-Coffee. 
 

5. Click Open. 
 

6. Click the Home tab.   
 

7. Click on the Component Button. 
 

8. In the Properties area, click the type drop-down and select the table you downloaded – you 
will have three size options – choose 36” x 72” x 18”. 
 

9. Place your cursor in the upper right area of the open space within the building, and place a 
table by clicking once. 
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10. Hit the Esc key twice.   
 

11. You will need to rotate the table 90 degrees.   
 

12. Place your cursor above the table until a vertical line appears.  
 

13. Click the mouse button and drag your mouse in a clockwise circle to change the angle of the 
table. 
 

14. With the angle at 90 degrees, click again.   
 

15. Hit the Esc key twice. 
 

16. Click the Modify button in the Ribbon, select the table, and move it to the front of the sofa 
(see image below).   
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Placing the Lounge Chairs 
 

1. Click the Insert tab. 
 

2. Click on Load Family on the ribbon. 
 

3. In the dialog box that appears, double-click the Furniture folder. 
 

4. Select Chair-Corbu. 
 

5. Click Open. 
 

6. Click the Home tab.   
 

7. Click on the Component Button. 
 

8. In the Properties area, click the type drop-down and select the chair you downloaded. 
 

9. Place your cursor in the upper right area of the open space within the building, and place two 
chairs. 
 

10. Hit the Esc key twice.   
 

11. Review the image below – this is the desired chair placement.  You will have to move one of 
the chairs, and then rotate and move the other. 
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12. Click the Modify button in the ribbon, and select one chair.  Move it above the coffee table. 
 

13. Select the other chair. 
 

14. Click on the Rotate tool in the ribbon. 
 

15. Place your cursor above the other chair until a vertical line appears.  
 

16. Click the mouse button and drag your mouse in a clockwise circle to change the angle of the 
chair. 
 

17. With the angle at 180 degrees, click again.   
 

18. Hit the Esc key twice. 
 

19. Click the Modify button, select the chair, and move it below the coffee table.   
 

 

 



	   129	  

Creating the Hardwood Floor 
 

1. Click the Floor button on the Home tab. 
 

 
 

2. In the Draw Panel of the Modify|Create Floor Boundary Tab, select the Pick Walls button. 
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3. You will notice the drawing has turned a lighter shade of gray – this is ok.  Single-click each 
exterior wall. 
 

   
 

4. On the Modify|Create Floor Boundary Tab, you will see a large green checkmark, called the 
Finish Edit Mode button, seen below.  Click this button to set the floor. 
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5. Finally, you will determine the floor type by selecting the Floor Type dropdown tab in the 
Properties box, and choose Wood Joist 10” – Wood Finish. 
 

 
 

 

 

Save and Close the Project 
 

1. On the main toolbar, click the Revit home button. 
 

2. Click Save. 
 

3. Click the Revit home button once more. 
 

Click Close.   
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Appendix G – Building Guidelines           

 

The following list was given to the constructivist groups as well as the second session of the 

behaviorist group as guidelines for the café drawing. 

 

1. East/West measuring 35’- 0” 

2. North/South measuring 45’- 0” 

3. Ceiling height – 10’- 0” 

4. Floor covering of your choice 

5. Interior bathroom – 10’- 0” x 10’- 0” 

a. 4” Brick interior walls 

b. Include sink 

c. Include commode 

6. Double doors on west (front) wall 

7. Single-door exit on side or rear of building 

8. Windows (2 or more) on exterior walls 

9. Seating for at least 24 patrons 
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Appendix H – Learning Stress Observation Record 
 
Observer ____________________________________________  Date ____________________   

Group Crimson  Group Slate 

 

 

Student _____________________________________ 
 

A:  

B:  

C:  

D:  

 

Student ____________________________________ 
 

A:  

B:  

C:  

D:  

 

Student _____________________________________ 

A:  

B:  

C:  

D:  

 

Student ____________________________________ 
 

A:  

B:  

C:  

D:  

 

Student _____________________________________ 
 

A:  

B:  

C:  

D:  

 

Student ____________________________________ 
 

A:  

B:  

C:  

D:  
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Student _____________________________________ 
 

A:  

B:  

C:  

D:  

 

Student ___________________________________ 
 

A:  

B:  

C:  

D:  

 

 

Stress Indicator Key (developed by the researcher and Committee Chair) 

 

A = Staring at computer screen – seemingly confused 

B = Disruptive behavior – does not have to be negative 

C = Nervous behavior (e.g. biting nails, sighing, fidgeting) 

D = Moving around, standing and sitting, clock watching 
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Appendix I – Post-Session Survey 
 
Name___________________________________________    ID# ______________    Date____________ 

 

 

Please use the scale below to answer the following 10 questions about your experience today.  
 

1. The project was difficult. 
 

 
1 

 
2 

 
3 

 
4 

Completely 
Disagree 

Moderately 
Disagree 

Moderately 
Agree 

Completely 
Agree 

 
 

2. I feel confident using the software after the session today. 
 

 
1 

 
2 

 
3 

 
4 

Completely 
Disagree 

Moderately 
Disagree 

Moderately 
Agree 

Completely 
Agree 

 
 
 

3. I feel I learned a great deal as a result of the session today. 
 

 
1 

 
2 

 
3 

 
4 

Completely 
Disagree 

Moderately 
Disagree 

Moderately 
Agree 

Completely 
Agree 
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4. I feel I could use the skills I learned today to complete a similar project in the future. 
 

 
1 

 
2 

 
3 

 
4 

Completely 
Disagree 

Moderately 
Disagree 

Moderately 
Agree 

Completely 
Agree 

 
 
 
 

5. I feel the skills learned today would be applicable in another class. 
 

 
1 

 
2 

 
3 

 
4 

Completely 
Disagree 

Moderately 
Disagree 

Moderately 
Agree 

Completely 
Agree 

 
 

6. I feel the skills learned today would be applicable in a future or current job. 
 

 
1 

 
2 

 
3 

 
4 

Completely 
Disagree 

Moderately 
Disagree 

Moderately 
Agree 

Completely 
Agree 
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Appendix J – Evaluation Protocol          Student Team______________ ID #__________ 

 

1. Did the student complete the project within the allotted time? 
 

 
Yes 

 
No 

 
 
 

2. On a scale from 1 to 5, rate the student’s level of technical accuracy as compared with the original model. 
 

 
1 

 
2 

 
3 

 
4 

 
5 

Not at all 
Accurate 

Somewhat 
Accurate 

Accurate Very Accurate Perfectly 
Accurate 

 
 
 
 

3. On a scale from 1 to 5, rate the student’s application of furniture and accessories as compared to the 
original model. 
 

 
1 

 
2 

 
3 

 
4 

 
5 

Not at all 
Accurate 

Somewhat 
Accurate 

Accurate Very Accurate Perfectly 
Accurate 

 
 
 
 

4. Did the student embellish or add extra elements or accessories? 
 

 
Yes 

 
No 
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